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1 Introduction

Chapter overview

Purpose This chapter contains information to simplify working with 
this manual.

Contents This chapter contains the following information:

› User groups of this manual . . . . . . . . . . . . . . . . . . . . . . . 7
› Structure of this manual  . . . . . . . . . . . . . . . . . . . . . . . . . 8
› Representations in this guide . . . . . . . . . . . . . . . . . . . . . 9
› Identification of the warning notices. . . . . . . . . . . . . . . 11
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User groups of this manual

Operators “Operators” are persons with right of disposal over the 
DISS 6 Software using this right for purchase or other pur-
poses.

Technical staff “Technical staff” are those persons that the operators en-
trust with tasks related to use and operation. Technical staff 
are trained by the operators to carry out their assigned 
tasks and are informed on the potential hazards that may 
arise due to improper handling.

Technical staff need to undergo a training by point elec-
tronic GmbH or a partner company of point electronic 
GmbH covering the following topics:

– Handling of the connected SEM
– Areas of application of the DISS 6 Software
– Handling of the DISS 6 Software
– Handling of the hardware
– Basic maintenance tasks and troubleshooting

Service technicians “Service technicians” are staff members whose specialist 
training, knowledge and experience as well as familiarity 
with the relevant safety regulations mean they are able to 
assess the tasks they have been entrusted with and antici-
pate potential hazards.

Service technicians may be:

– Employees of point electronic GmbH or
– Employees of partner companies of point electronic 

GmbH
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Structure of this manual

Purpose This user guide describes installation, structure and calibra-
tion of the DISS 6 Software.

Composition This user guide is composed of chapters which are orga-
nized by technical aspects.

Numbering The chapters are numbered with Arabic numerals. Chap-
ters may be composed of sections. Sections are numbered 
as second numbering level (e. g. 3.1). Sections are used to 
structure large chapters into sub-chapters.

All pages of this user guide are numbered consecutively.

Overviews Each chapter and section contains an overview detailing 
contents and page numbers. This allows for direct access to 
a topic and independent use of single parts of this user 
guide.

Related information Related information within the user guide is marked by the 
note “Continuation next page …” resp. “... continuation:”. 
Please pay attention to the completeness of the informa-
tion when copying parts of the user guide.

Cross references The content of this user guide is structured by topics. If fur-
ther information on one topic may be found elsewhere in 
the user guide, the relevant chapter and page are pointed 
out.
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Continuation next page … 

Representations in this guide

Illustrations Illustrations used in this manual do not always contain all 
details or special cases. They only represent the relevant in-
formation.

Menu functions In this manual, the various menu functions are presented as 
follows:

Finding a menu point: File > Open

Keyboard shortcuts Frequently used functions and instructions may be acti-
vated by using certain key combinations. These are pre-
sented as follows:

Inputs and outputs Certain recurring symbols or descriptions are used to sym-
bolize possible screen inputs and outputs. These are used 
as follows:

Mouse functions The following table explains the concepts used in this man-
ual to describe the handling of the mouse:

Keyboard shortcut Representation

Key [Ctrl]

Key combination [Ctrl]+[Alt]

Inputs and outputs Representation

Buttons Button

Dialog window Dialog window

Elements of the user interface GUI element

Concept Explanation

Click Singular pressing of the left mouse button.

Double-click Quick double pressing of the left mouse 
button.

Right-click Singular pressing of the right mouse button.

Pressed mouse but-
ton

Left or right mouse button is kept pressed 
during a process.

Drag & Drop “Drag & Drop”
Click on an element of the user interface, 
drag the element with pressed mouse but-
ton to another position, drop the element 
to this position.
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… Continuation: Representations in this guide

Icons The following icons are used to mark certain information vi-
sually:

Notes Important notes are marked as follows:

Icon Meaning

Notice
For example:

The selected parameter will not be inserted in the 
parameter order.

Reference to another part of this guidebook
For example:

see “Cross references” on page 8

Use of a tool
For example:

Screwdriver TX 10

NOTICE

Mind the notices in this guidebook!

Notes explain relations that even for expert users might 
not be evident at first glance.
The neglect of a note is no direct security risk. However, 
it can lead to disturbances in the operating procedure.
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Identification of the warning notices

Purpose This operating manual includes warning notices that may 
lead to serious consequences if disregarded. Warning no-
tices are not only listed in the “Safety regulations” chapter, 
but especially in places where hazards for people, equip-
ment and operation may arise.

Identification of warnings There are three classes of warnings. These classes are indi-
cated by specific signal words and colors. They include the 
following:

Signal word Meaning

Warning notice, which if disregarded will 
probably or very likely result in death or seri-
ous injury.

Warning notice, which if disregarded may 
result in serious injury, permanent damage to 
health or serious property loss.

Warning notice, which if disregarded may 
result in injury or property loss including finan-
cial losses due to operational impairment.

DANGER

WARNING

CAUTION
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2 System overview

Chapter overview

Purpose This chapter describes the DISS 6 Software. It contains in-
formation on system requirements as well as general de-
scriptions of the software functions.

Contents This chapter contains the following information:

› System requirements. . . . . . . . . . . . . . . . . . . . . . . . . . . 13
› System description  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
› Sliders and input fields  . . . . . . . . . . . . . . . . . . . . . . . . . 15
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System requirements

Computer system The following table contains information on the minimum 
requirements of the computer’s system:

Component Minimum requirement

Computer IBM-compatible from Core i3
Recommendation: Core i5

Operating system From Windows 10 (32/64 Bit)

RAM 8 GB

Graphics Resolution at least 1280 x 1024 pixels, true 
color
Recommended resolution: 1920 × 1200 pixels

Interfaces Minimum one available USB 2.0 or USB 3.0 slot

Periphery Mouse with mouse wheel
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System description

Introduction DISS 6 is an active image acquisition and processing system 
for scanning electron microscopes (SEM), scanning trans-
mission electron microscopes (STEM) and electron micro-
probe analyzers (EMPA).

DISS 6 may be installed on all commercially available opto-
electronic devices. The installation will not affect any func-
tions of these devices.

During the digital image acquisition, the internal scan gen-
erator will be turned off, and the beam control of DISS 6 
will take over.

Components The overall systems consists of:

– DISS 6 hardware,
– DISS 6 Software and
– digital image processing system DIPS.

DISS 6 hardware The DISS 6 hardware completes the following tasks during 
image acquisition:

– switches the optoelectronic device via hardware or soft-
ware to external beam control (device-dependent)

– generates X and Y deflecting voltages
– digitizes the analog image signals (SE, BSE, CL)
– counts the impulses of an EDX or WDX system for each 

pixel for the creation of elemental mapping images or 
concentration profiles (optional)

DISS 6 Software In standard configuration, image acquisition is simultane-
ously possible from up to 4 analog and 12 impulse signals. 
The analog input signal channels may be extended by 4, 8 
or 16 channels.

Image format and resolution are freely selectable. A region 
scan with zoom function facilitates focusing and astigma-
tism correction. Apart from adjustable scan time, functions 
like line averaging and frame averaging improve the signal-
to-noise ratio.

Image processing software With DIPS, all digitized images may be processed, labeled, 
measured, printed and saved easily. A special layout tech-
nique facilitates the processing of several related images as 
well as documentation and archiving of image data.
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Sliders and input fields

Operation of the sliders Use of the sliders with the mouse allows for a very fine set-
ting for high-resolution D/A converters as well as simple 
manipulation for fast coarse setting.

As a default, the slider function Standard is activated, how-
ever, this might be changed in the file DISS6.ini.

The following table contains information on operating the 
sliders with the mouse:

Slider function Operation

Standard
Entry in DISS6.ini: 
HiResSliders=1

The mouse button does not have to be held during slider setting.
1. Click a slider.

 The slider is coupled to the mouse pointer (X/Y).
2. Any further click: Switches between fine and coarse setting. In 

the coarse setting, the slider is displayed in red.
3. Move the mouse to change the slider value.
4. Right-click the slider to uncouple the slider from the mouse 

pointer.
 The slider flashes.

5. Optional: Adjust the slider value by turning the mouse wheel (see 
slider function Blink).

6. Perform any other action (e. g. select a different slider, click a but-
ton, ...) to end mouse operation.

Pressing the [Esc] key cancels the mouse operation and resets the 
slider to its initial value.

Alternative
Entry in DISS6.ini: 
HiResSliders=2

The mouse button has to be held during slider setting.
1. Click a slider and keep the mouse button pressed.
2. Press the space bar to switch between fine and coarse setting. In 

the coarse setting, the slider is displayed in red.
3. Move the mouse or turn the mouse wheel (see slider function 

Blink) to modify the slider value.
4. Release the mouse button.

 Mouse operation ends.
 The preset values are saved.

Basic
Entry in DISS6.ini: 
HiResSliders=0

Direct control of the slider with the mouse button.
1. Click a slider and keep the mouse button pressed.
2. Press the space bar to switch between coarse and fine setting. In 

the fine setting, the slider is displayed in green.
3. Move the mouse or turn the mouse wheel (see slider function 

Blink) to modify the slider value.
4. Release the mouse button.

 Mouse operation ends.
 The preset values are saved.
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Input fields The preferred values may be entered in the white input 
fields. When the values are confirmed with the Return key, 
the numbers change from red to black.

Blink Operating the sliders with the mouse wheel in the Standard, Alterna-
tive and Basic functions.
1. Right-click a slider.

 The slider is selected and flashes.
2. Turn the mouse wheel to change the slider value as follows:

– Turning the mouse wheel: Changes the value in X direction.
– Pressing [Shift] and turning the mouse wheel: Changes the 

value in Y direction.
– Additionally holding the [Ctrl] key: Changes the value by the 

factor 10.
– Additionally holding the [Ctrl]+[Alt] keys: Changes the value by 

the factor 100.
3. Optional: Set the slider to a central position as follows: 

– Press [*] for horizontal central position
– Press [Shift]+[*] for vertical central position

4. Perform any other action (e. g. select a different slider, click a but-
ton, ...) to end mouse operation.
 Mouse operation ends.

Slider function Operation
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3 Installation

Chapter overview

Purpose This chapter contains information and instructions on the 
installation of the DISS 6 Software and adjustment of the 
DISS 6 hardware.

Contents This chapter contains the following information:

› Software installation  . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
› Adjustment of the DISS 6 hardware . . . . . . . . . . . . . . . 19
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Software installation

Installer The DISS 6 Software is provided on a flash drive. Running 
the file “diss6setup.exe” launches the installer.

The installer installs the following components:

– PE USB driver (compatible from Windows 10, 32/64 bit)
– DISS 6 Software
– Digital Image Processing System DIPS
– Configuration files
– Documentation

Steps Complete the following steps to install the DISS 6 Soft-
ware:

1. Connect the provided flash drive to the computer.
2. Start the file “diss6setup.exe” from the flash drive.
3. Follow the instructions on the screen.

 The installation proceeds. Application and neces-
sary driver are installed.

NOTICE

Install the software before connecting the hardware!

Always install the DISS 6 Software first before connect-
ing the hardware to the PC.

NOTICE

User interface language

The user interface of the DISS 6 Software is only avail-
able in English.

CAUTION

Maintain software settings during upgrades!

During upgrading an older version, two confirmation 
prompts will appear on the screen. You will have to con-
firm whether or not the current installation is to override 
the existing configuration files.
– Click No in both confirmation prompts to maintain 

your software settings and to use them for the DISS 6 
Software.
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Adjustment of the DISS 6 hardware

Objective The objective of the adjustment is matching the images on 
the SEM screen with the DISS image window regarding 
brightness, contrast and image dimensions.

A test sample with known geometric structures is necessary 
for the adjustment of the DISS 6 hardware.

Before getting started Complete the following steps before starting to adjust the 
DISS 6 hardware:

1. Open the DISS 6 Software on your computer.
2. Press the [Ctrl]+[Alt]+[A] key combination.

 The Adjustment dialog window opens
3. Start a live scan.

see “Live Scan” on page 73

Adjustment Complete the following steps to adjust the DISS 6 hard-
ware:

1. Adjust brightness and contrast in the Fast A and Fast B 
tabs.
By adjusting the input A1, A2, A3 or A4 used by (con-
trast) and (brightness), the analog inputs are adapted 
to the image signals. The inputs A3 and A4 are only in-
cluded as options.
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… Continuation: Adjustment of the DISS 6 hardware

2. Adjust image dimensions in Scan tab.
With the sliders, image position (Gain) and image di-
mensions (Offset) may be adjusted to the SEM in X di-
rection (line) and Y direction (frame).

3. Checking the adjustment in a slow scan.

see “Slow Scan” on page 77

Saving adjustment settings
in the device

If the Save persistent checkbox is activated, the adjustment 
settings of the DISS 6 hardware will be saved within the de-
vice.

NOTICE

Adjusting the scan polarity

If the image is mirrored horizontally or vertically, the 
scan polarity may be adjusted with help of the Invert X 
and / or Invert Y checkboxes.
This adjustment will only be applied after a restart of the 
image.
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4 Stage control (optional)

Chapter overview

Purpose This chapter contains descriptions on the structure and 
function of the Stage optional control panel.

Contents This chapter contains the following information:

› Control panel. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22
› Main field. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
› Main tab  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
› Position Table tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
› Setup tab. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
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Control panel

Description The Stage control panel controls a motorized sample stage. 
This means that fixed positions may be saved and ap-
proached. It also allows to move the stage by image fields 
or to optionally move it with a connected joystick.

Structure The following figure shows the Stage control panel with the 
following components:

1

2
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… Continuation: Control panel

Function The following table contains information on the main com-
ponents of the Stage control panel:

No. Main component Function

1 Main field
(Page 24)

Contains functions for controlling and monitoring the sample stage.

2 Tabs

– Main
(Page 29)

Shows a set (table) of predefined positions.
By double-clicking a table row, the stage will be moved to the corre-
sponding position.

– Position Table
(Page 31)

Allows for creating, saving, loading and using customized position 
sets.

– Setup
(Page 33)

Contains functions for setting up the sample stage control.



Stage control

point electronic GmbH DISS 6 Software 24 / 206

Version: 6.4.0.0 Reference guide 26.02.2025

Continuation next page … 

Main field

Structure The following figure shows the main field of the Stage con-
trol panel with the following components:

Function The following table contains information on the compo-
nents of the main field:

Component Function

Input fields X, Y, Z, T, R, S Entering of values for moving the sample stage:
– X and Y for planar moves
– Z for distance from the sample (with motorized Z axis only)
– T for sample stage tilt (device-dependent)
– R for sample stage rotation (with motorized R axis only)
– S for Z fine tune (device-dependent)
The current position of the axis is displayed above the input fields.
Underneath the input fields, 3 status displays are visible,

see “Status” on page 26

Move Moving the sample stage to the set position.

Stop Stopping the sample stage.

Relative Pos With activated checkbox, the positions entered in the input fields will 
be approached relative to the respective current position.

Motors On Activation/deactivation of the sample stage motors.

Correct SR Correction of scan rotation.
Activating/deactivating the approach correction of the sample stage.
With activated checkbox, the move of the sample stage will be cor-
rected according to the preset scan rotation. This means that the 
sample stage always takes the correct approach to the SEM image.
With deactivated checkbox, the sample stage takes the correct 
approach to the camera image.
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Continuation next page … 

Activation/deactivation of the mouse click shift.
If shifting by mouse click has been activated, the double-clicked 
image area is moved to the center of the image.

Activates / deactivates rotating by mouse click (only available with 
motorized rotation).
If rotating by mouse click has been activated, a line can be drawn in 
the image acquisition window by moving the mouse:

The first click sets the beginning of the line. The second click sets the 
end.
 After the second click, the sample stage will be rotated so that the 

line drawn in the image acquisition window will be horizontal:

If you keep the Shift key pressed during the second click, the line 
will be turned vertical.

The sample is rotated in the sample center. This means, X and Y 
will also be shifted. The accuracy of this functions depends on the 
used device.

This function only works if the rotation center of the sample stage 
is the home position.

Component Function
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Status Underneath each of the X, Y, Z, T, R and S input fields, 
three different status displays are visible:

The following table contains information on the different 
status displays:

Working distance is in focus (only available with motorized Z axis).
1. Focus on the sample and click WD in Foc to couple the sample 

stage's Z axis to the focus.
 WD in Foc remains activated, and the label of the input field Z 

is changed to F.
2. In the input field F, enter the particular value for the working dis-

tance (inverted to Z).
 When shifting the height, the focus will follow automatically. 

Additionally, a software limit is activated to prevent collision 
with the pole piece.

By clicking the activated button WD in Foc, the function will be 
deactivated, and Z axis and focus will become uncoupled.
The limit will be calculated from current working distance and current 
sample position minus a configurable safety distance:
Zmax = WDcurrent + Zcurrent – safety distance

Set movement of the sample stage:
– Click the H button to return the sample stage to Home position.
– Click the B button to perform a manual backlash (e. g. when using 

a trackball or joystick).
– Click the arrow buttons to move the sample stage by image fields 

in the indicated direction.
The settings in the checkboxes on the right-hand side define the 
distance of the stage's movements. Setting 1 corresponds to mov-
ing along the length of the image in the image acquisition window, 
1/2 corresponds to one half of the image length, 1/3 corresponds 
to one third etc.

Component Function

WD in Focus

31 2

No. Status display Color Status

1 Left-side limit  gray No limit

 green Software limit

 red Hardware limit

2 Motor status  gray Motor off

 green Motor on
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Continuation next page … 

Initialization If the control happened electroless, the sample stage is not 
initialized anymore. During starting SEM control, the dialog 
window Stage Reference Position will be displayed:

Click the button Initialization Run in the Stage Refer-
ence Position dialog window to initialize the sample stage.

During the initialization run:

1. The lower limit of Z will be searched for and the sam-
ple will be moved downwards.

2. The limit of all other axes will be searched for.
3. The sample stage will be moved to Home position af-

ter successful initialization.

 red Motor error

The motors have to be turned off via the Motors 
On checkbox and turned on again.

3 Right-side limit  gray No limit

 green Software limit

 red Hardware limit

No. Status display Color Status
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Use Uninitialized If you click the button Use Uninitialized in the Stage Ref-
erence Position dialog window, no initialization run will be 
performed. The limits will not be determined. An uninitial-
ized sample stage will be displayed with red numbers in the 
main field panel:

NOTICE

If the sample stage has not been initialized, the absolute 
position cannot be determined. The calibration of the 
axes will not be affected. Thus relative travel paths will 
still be correct.
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Main tab

Structure The following figure shows the Main tab of the Stage con-
trol panel:

Function The Main tab contains a table with a set of preset positions. 
By double-clicking a line, the stage will be moved to the 
corresponding position.

Main Table editing mode If the Main Table editing mode checkbox is activated in the 
Setup tab, the Main tab will display additional buttons for 
changing the table values:

In Main Table editing mode, the values in the Main tab as 
well as the values in the Position Table tab may be modi-
fied.
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The following table contains information on the additional 
buttons in the Main Table editing mode:

Button Function

Load Table Loads a set of positions from an excel file.

Save Table Saves a set of positions to an excel file.

Clear Table Deletes all values from the table.

Add Position Adds the current stage position to the table.

Goto Position Moves the sample stage to the position 
selected in the table.
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Position Table tab

Structure The following figure shows the Position Table tab of the 
Stage control panel:

Function The following table contains information on the compo-
nents of the Position Table tab:

Component Function

Table Defining customized position sets.
Each line contains the data of a sample stage position as well as a 
comment on this position.
By double-clicking a line, the stage will be moved to the correspond-
ing position.
By clicking a cell in the Comment column, the corresponding com-
ment may be modified.
A right-click on a line opens a context menu with the following items:
– Goto Position: Moves the sample stage to the position of the 

selected line.
– Insert Position: Inserts the current position as new line after the 

selected line.
– Replace Position: Replaces the selected line with the current posi-

tion.
– Delete Position: Deletes the selected line.
– Set Inputs: Transfers the positions of the selected line to the input 

fields in the main field.
– Load Table: Loads a set of positions from an excel file.
– Save Table: Saves a set of positions to an excel file.

Load Table Loads a set of positions from an excel file.

Save Table Saves a set of positions to an excel file.

Clear Table Deletes all values from the table.

Add Position Adds the current stage position to the table.
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Goto Position Moves the sample stage to the position selected in the table.

Component Function
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Setup tab

Structure The following figure shows the Setup tab of the Stage con-
trol panel:

Function The following table contains information on the compo-
nents of the Setup tab:

Component Function

Initialization Run Manually starts an initialization run.

see “Initialization” on page 27

Set current Position as 
Home

Defines the current position as Home.

Main Table editing mode If activated, the values in the Main tab may be modified as well as the 
values in the Position Table tab.

Move to Home on Exit If activated, the sample stage will be moved to Home position when 
the program is closed.

Move to Home on Vent If activated, the sample stage will be moved to Home position when 
the sample chamber is vented.

Active Zones Activation/deactivation of up to 4 cuboid zones that the sample 
stage will not enter.

These zones may be defined by an administrator.
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5 Image acquisition

Chapter overview

Purpose This chapter gives information on the image acquisition of 
DISS 6 Software. It contains descriptions of structure and 
function of the image acquisition.

Contents This chapter contains the following sections:

› 5.1 User interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
› 5.2 Functions in the File menu . . . . . . . . . . . . . . . . . . . 48
› 5.3 Functions in the Info menu . . . . . . . . . . . . . . . . . . . 65
› 5.4 Toolbar functions  . . . . . . . . . . . . . . . . . . . . . . . . . . 69
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5.1 User interface

Overview

Purpose This section contains descriptions on the structure and 
function of the image acquisition software’s user interface.

Contents This sections contains the following information:

› Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36
› Menu bar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38
› Toolbars. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40
› Image acquisition window. . . . . . . . . . . . . . . . . . . . . . . 43
› Image preview. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
› Hint  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
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Overview

Structure The following figure shows the Image acquisition user in-
terface of the DISS 6 Software with its main components:

Function The following table contains information on the main com-
ponents of the user interface:

X: 16,46 μm Y: 15,40 μm D: 22,54 μm

ROI Live Slow Counter Point/Line Beam Stop TIFF Video Topo Signal Monitor Channel Mixer Save… Fast Save Auto Save

File View Info

Fast 1000
04.2.20 09:35:00
Mag: 750x
HV: 20 kV
WD: 300 μm

Adjust…AC

125

Gain

0,005

Input Offset (Low)
BSE

Inspector
SE -0,500 V (0)
InLens -0,500 V (0)
BSE 1 0,001 V (0)
BSE 2 0,002 V (0)
BSE 3 0,002 V (364)
BSE 4 0,003 V (339)

BSE
Inspector

SE 0%X: 20,00 μm Y: 26,00 μm D: 36,77 μm

SE

750x | Pix: 9,071 nm

1,505 mm | 1,003 mm

300 μm

Comment

Slow Scan @ 100,0%

Digital Image Scanning System 6 (USB)

1

2

3

4

5 6

7

No. Main component Function

1 Menu bar Global settings.

see “Menu bar” on page 38

2 Toolbars Tools for acquisition, settings and management of images.

see “Toolbars” on page 40

3 Image acquisition 
window

Shows the current scanning process of one or more signal sources 
with differing parameter values (depending on settings).

see “Image acquisition window” on page 43

4 Image preview Clipboard of acquired images.

see “Image preview” on page 46
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5 Hint Displays selected meta data of images.

see “Hint” on page 47

6 Status bar Shows the values of the current measurement (e. g. X/Y position and 
working distance).

7 Sidebar Includes control panels for differing functions.

The available control panels depend on the specific configuration 
of the DISS 6 Software.

see “Optional control panels” on page 124

No. Main component Function
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Menu bar

File menu The following figure shows the File menu with the following 
components:

The following table contains information on the compo-
nents of the File menu:

View menu The following figure shows the View menu with the follow-
ing components:

The following table contains information on the compo-
nents of the View menu:

Component Function

Preferences… Opens the Preferences dialog window for 
global preferences to save and name the 
images.

File View Info

Preferences…

Component Function

Acquisition Toolbar Activates/deactivates the “Acquisition” tool-
bar with scanning functions.

Tools Toolbar Activates/deactivates the “Tools” toolbar.

File Toolbar Activates/deactivates the “File” toolbar with 
saving functions.

Image Preview Activates or deactivates the image preview.

File name Shows the name of the current image.

File View Info

Acquisition Toolbar

Tools Toolbar

File Toolbar

Image Preview F12

1 24-13-05-16-10-45-178.tif (100,0%)
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Info menu The following figure shows the Info menu with the follow-
ing components:

The following table contains information on the compo-
nents of the Info menu:

Component Function

Contents Opens the reference guide in a separate win-
dow.

point electronic 
homepage

– Establishes a connection to the Internet.
– Opens the website pointelectronic.de in a 

browser window.

Environment… Opens a dialog window that shows the saving 
locations of the configuration files and loaded 
plug-ins.

About… Opens a dialog window with information on 
the installed version of the DISS 6 Software 
and the connected DISS 6 hardware.

File View Info

Contents F1

About…

point electronic homepage

Environment…
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Toolbars

Acquisition The following figure shows Acquisition toolbar with its but-
tons:

The following table contains information on the Acquisition 
toolbar buttons:

ROI Live Slow Counter Point/Line Beam Stop

Button Function Description

Region Scan
(Page 70)

Starts a Region Scan.

Live Scan
(Page 73)

Starts a continuous live preview.

Slow Scan
(Page 77)

Starts a slow scan.

Counter Scan
(Page 81)

Starts a counter scan for counting TTL impulses.

Line scan/point measure-
ment
(Page 85)

Opens a dialog window for set-up and operation of 
line and point measurements.

Beam positioning
(Page 102)

For positioning the electron beam on the sample.

Stop
(Page 103)

Cancels an ongoing scanning process.
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Optional extensions The following figure shows the optional extensions toolbar 
with its buttons:

The following table contains information on the optional 
extensions buttons:

Tools The following figure shows the Tools toolbar with its but-
tons:

The following table contains information on the Tools tool-
bar buttons:

TIFF Video Topo

Button Function Description

TIFF Recorder 
(optional)
(Page 104)

Opens a dialog window for setting and recording bit-
map images in a continuous scan.

Video Recorder 
(optional)
(Page 106)

Opens a dialog window for setting and recording vid-
eos in a continuous scan.

BSE Topography 
(optional)
(Page 109)

Opens a dialog window for generation, visualization 
and export of a 3D surface model in live mode.

Signal Monitor Channel Mixer

Button Function Description

Signal Monitor
(Page 115)

Opens the signal monitor.

Channel Mixer
(Page 117)

Opens a dialog window for live mixing of image sig-
nals.
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File The following figure shows the File toolbar with its buttons:

The following table contains information on the File toolbar 
buttons:

Save… Fast Save Auto Save

Button Function Description

Save
(Page 121)

Opens a dialog window for saving the current image or 
layout.

Fast Save
(Page 122)

Saves the current image or layout without opening an 
image window.

The current image or layout will be saved in the set 
saving location under the set automatically assigned 
file name.

Auto Save
(Page 123)

If Auto Save is activated, the current image or layout 
will be saved automatically after completion of the 
scanning process.

The current image or layout will be saved in the set 
saving location under the set automatically assigned 
file name.
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Continuation next page … 

Image acquisition window

Structure The following figure shows the image acquisition window 
with its components:

Function The following table contains information on the compo-
nents of the image acquisition window:

SE 0%X: 20,00 μm Y: 26,00 μm D: 36,77 μm

SE

750x | Pix: 9,071 nm

1,505 mm | 1,003 mm

300 μm

Comment

Slow Scan @ 100,0%

Component Function

Title bar Shows the name of the current scan and the window magnification as 
percentage.

Comment field For entering an image comment.
Previously entered comments may be chosen from a history.

Deposits the scanned image in the image preview bar.

Image Shows the current scanning process.

Header within image
Page 61

Shows values of several parameters that may be set in the live over-
lay settings.
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… Continuation: Image acquisition window

Continuation next page … 

Multiple input signal
sources

Depending on the scan settings, multiple (analog and digi-
tal) signal sources may be acquired and displayed in the im-
age acquisition window.

The following figure shows the image acquisition window 
with several input signal sources:

Footer within image
Page 60

– Shows values of several parameters that may be set in the live 
overlay settings.

– On the bottom right in the footer, the Micron bar showing the 
scale of the image will always be displayed.

Status bar Shows information on the current scanning process:
– Current input signal source
– Measurement data
– Scanning progress in percent

Component Function

SE 0%X: 20,00 μm Y: 26,00 μm D: 36,77 μm

Comment

A1 A1

A1 A1

Slow Scan @ 100,0%
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… Continuation: Image acquisition window

The following table contains information on further compo-
nents of the image acquisition window with several input 
signal sources:

Context menu Right-clicking the image acquisition window opens a con-
text menu.

The following table contains information on the compo-
nents of the context menu:

Component Function

Comment field For entering or selecting a global comment.
The global comment applies to all input signal sources.

Input fields of the individual 
input signal sources

For entering or selecting a comment for each input signal source.
In the input fields, the default signal name may be replaced by per-
sonal inputs.

Component Function

Measurement Lines Activates or deactivates horizontal and verti-
cal measurement lines.
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Image preview

Description The acquired images are temporarily saved in the image 
preview and will be shown there as thumbnails.

By clicking on a thumbnail, the corresponding image opens 
up. The selected thumbnail is highlighted in blue.

Structure The following figure shows the image preview with the hint:

Context menu Right-clicking a thumbnail opens a context menu.

The following table contains information on the compo-
nents of the context menu:

Fast 1000
04.2.20 09:35:00
Mag: 750x
HV: 20 kV
WD: 300 μm

Component Function

Delete Deletes the image.

Hint Settings… Opens the Hint Settings dialog window.

see “Hint Settings” on page 47
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Hint

Description The Hint field shows image data of an image in the image 
preview. Image hints will be displayed as soon as the 
mouse cursor is placed on that image.

The information shown is saved as meta data in XMP for-
mat with the acquired image. Such meta data may for in-
stance contain image comments, acquisition date or 
magnification.

Hint Settings Use the right mouse button to click on an image in the im-
age preview and choose Hint Settings… from the context 
menu to open the Hint Settings dialog window:

The following table contains information on the compo-
nents of the Hint Settings dialog window:

Hint Settings

Enable Thumbnail Hint Parameters…

CancelOK

{ScanName}
{Description}

Component Function

Enable Thumbnail Hint Activates/deactivates the display of hints in the image preview.

Parameters…
Page 63

Opens the Parameters dialog window for setting and inserting 
global parameters for hints display.

Parameter field In the Parameter field, parameters are inserted and arranged.
Parameters are displayed symbolically as parameter name in curly 
brackets. Between parameters, any text (including special characters 
or breaks) may be inserted.

OK Closes the dialog window.
The preset parameters are saved.

Cancel Closes the dialog window.
The preset parameters are rejected.
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5.2 Functions in the File menu

Overview

Purpose This section contains descriptions on the structure and 
function of the File menu components.

Contents This sections contains the following information:

› Preferences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
› Configuring Save buttons . . . . . . . . . . . . . . . . . . . . . . . 53
› Configuring live overlay  . . . . . . . . . . . . . . . . . . . . . . . . 59
› Configuring parameters  . . . . . . . . . . . . . . . . . . . . . . . . 63
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Continuation next page … 

Preferences

Description The Preferences function sets the global preferences for 
the DISS 6 Software.

General tab In the General tab, general settings for the DISS 6 Software 
can be found.

The following figure shows the Preferences dialog window 
with the General tab:

The following table contains information on the compo-
nents of the General tab:
.

Component Function

Save Buttons Shows the configured Save buttons.
Save buttons may be selected by clicking on them.

– Configure… 
(Page 53)

Configures the selected Save button.
Opens the Save Settings dialog window.

– Add… For adding Save buttons.
Opens the Save Settings dialog window.

– Delete Deletes the selected Save button.

– Standard For defining the selected Save button as default.
The default Save button will be used:
– for the Save Image… function in the channel mixer
– for the Image Export… function in line scan / point measurement

– Auto save button Hiding or unhiding the Auto save button.
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… Continuation: Preferences

Continuation next page … 

Scan Buttons tab The Scan Buttons tab contains functions for configuring the 
Scan buttons.

The following figure shows the Preferences dialog window 
with the Scan Buttons tab:

Configure Live Overlay…
(Page 59)

Configures header and footer of the image acquisition window.
Opens the Live Overlay Settings dialog window.

Magnification required Activates a warning if no value is entered in the Mag field.

This function will be deactivated if the magnification is read out 
automatically.

Description required Activates a warning if no image description has been entered for the 
image acquisition.

Image Counter Enables setting/resetting the consecutive image number.

Point/Line scan Activates warnings when closing the Point/Line Measurement dialog 
window.

– Image/Profile export 
required

Activates a warning if no image or diagram is exported.

– Data export required Activates a warning if no data is exported.

OK Closes the dialog window.
The settings are applied.

Cancel Closes the dialog window.
All settings are rejected.

Component Function

1

3

2
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… Continuation: Preferences

Continuation next page … 

The following table contains information on the compo-
nents of the Scan Buttons tab:

No. Component Function

1 Button order Preview of the Scan buttons order in the image acquisition bar. 
Scan buttons may be selected by clicking on them.

2 Sorting buttons
 selected Scan button up

 selected Scan button down

Delete Deletes the selected Scan button from the button order.

3 Template selection Selecting a configured template for a Scan button.

Add... Creating a new Scan button from a selected template.
Opens the Scan Button Caption dialog window for defining a Scan 
button caption.

OK Closes the dialog window.
The settings are applied.

After creating new Scan buttons and clicking OK, a warning tells 
you that you have to close and restart the software. Without 
restarting the software, new Scan buttons will not be displayed, 
and all changes to existing Scan buttons settings from this point 
on will be lost.

Cancel Closes the dialog window.
All settings are rejected.
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… Continuation: Preferences
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Continuation next page … 

Configuring Save buttons

Description Save button saving parameters may be configured in the 
Save Settings dialog window. Saving parameters may in-
clude image format and image captions among others.

The Save Settings window opens after a right-click on a 
Save button or after clicking the Configure… or Add… 
buttons in the Preferences dialog window in the General 
tab.

General settings The general settings in the Save Settings dialog window 
may be entered regardless of the chosen tab.

The following table contains information on the general 
settings in the Save Settings dialog window:

Component Function

Button Caption For entering the Save button caption.

Hotkey For entering a Save button hotkey.
For recording a hotkey, place the cursor in the Hotkey text field and 
press the particular key or key combination.

OK Closes the dialog window.
The settings are applied.

Cancel Closes the dialog window.
All settings are rejected.
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… Continuation: Configuring Save buttons

Continuation next page … 

File tab The following figure shows the Save Settings dialog 
window with the File tab:

The following table contains information on the compo-
nents of the File tab:

Component Function

File Format Setting one or more formats for saving the acquired images.

8 Bit Settings for the 8 Bit format.

– Store TIF Activated: Acquired images are saved as 8 Bit TIFF file.

– Footer & Micron Bar Activated: Footer and Micron Bar are saved within the 8 Bit TIFF 
image.

– RGB Activated: The image is saved in RGB colors.
Deactivated: The image is saved in 256 gray scales.

– Save Single Images Activated: Images acquired with multiple input signal sources are 
saved as single frames. The signal names will be added as file name 
extension.
Deactivated: The images are saved in a 8 Bit multipage TIFF file.

– JPG Activated: Acquired images are saved as 8 Bit JPG file.

– Footer & Micron Bar Activated: Footer and Micron Bar are saved within the 8 Bit JPG 
image.
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16 Bit Settings for the 16 Bit format.

– Store TIF (RAW Data 
without Footer)

Activated: Acquired images are saved as 16 Bit TIFF file in RAW for-
mat.

Only the image’s raw data will be saved. It is not possible to save 
footers in the image.

– Save Single Images Activated: Images acquired with multiple input signal sources are 
saved as single frames. The signal names will be added as file name 
extension.
Deactivated: The images are saved in a 16 Bit multipage TIFF file.

– Add Postfix Enter a postfix.
The entered postfix will be added to the file name of the images in 
16 Bit format during saving.

– Use Sub Folder Enter the name of the subfolder.
When saving the images, a subfolder will be generated at the 
selected saving location under the entered name. The images in 16 
Bit format will be saved in this folder.

Image Resolution For setting the image resolution that will be saved in the TIFF files (8 
Bit and 16 Bit format).

– System Resolution (Stan-
dard)

The magnification set in SEM will be used as resolution and is correct 
at an image width of 127 mm.

– Monitor Resolution The resolution set for the connected monitor will be used. Thus, the 
{TrueMag} parameter will be correct at display at true size (1:1).

Auto File Name For activating/deactivating the automatic generation of file names.
The chosen file name is automatically suggested when images are 
saved.

– Text field For inserting and arranging the parameters of the automatically gen-
erated file name.
Parameters are displayed symbolically as parameter name in curly 
brackets.
Between the parameters, text, space and/or dividers may be 
entered.

– Parameters… 
(Page 63)

Opens the Parameters dialog window for selecting, setting and 
inserting the global parameters for the automatic generation of file 
names.

Auto Folder For activating/deactivating the automatic generation of folders.

– Base Displays the path of the selected saving location.

– Folder… Opens a dialog window for selection of the saving location.

– Sub For inserting and arranging the parameters of the automatically gen-
erated subfolder structure. This structure will be generated during 
saving of images at the selected saving location.
Parameters are displayed symbolically as parameter name in curly 
brackets.

Component Function
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… Continuation: Configuring Save buttons

Continuation next page … 

Inscription tab for footer The following figure shows the Save Settings dialog 
window with the Inscription tab and the settings for the 
footer within the image:

– Parameters… 
(Page 53)

Opens the Parameters dialog window for selecting, setting and 
inserting the global parameters of the automatic generation of fold-
ers.

Example Shows a preview of the automatic file name in the automatic folder 
structure.

OK Closes the dialog window.
The settings are applied.

Cancel Closes the dialog window.
All settings are rejected.

Component Function
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… Continuation: Configuring Save buttons

Continuation next page … 

The following table contains information on the settings of 
the footer in the Inscription tab:

Component Function

Text field For inserting and arranging the parameters in the footer.
Parameters are displayed symbolically as parameter name in curly 
brackets.
After the parameter name, within the curly brackets, the percentage 
of the parameter indentation (from left) may be inserted separated 
by a semicolon, e. g.: 
– {SignalName;x=35} – This parameter will be indented to the left by 

35% of the total image width in the footer.
– {FieldOfView;x=100} – This parameter will be aligned in the footer 

to the right-hand margin of the image.
Between parameters, any text (including special characters or 
breaks) may be inserted.

Parameters…
(Page 63)

Opens the Parameters dialog window for selecting, setting and 
inserting the footer parameters.

Text

– Color Setting the text color.

– Font Setting the font.

– Anti-Aliasing Activating/deactivating anti-aliasing.

– Height Setting the font size.

– Height selection list Setting the font size unit:
– Relative (% of Width/Height) – Font size as percentage relative to 

image width and image height.
– Relative (% of Height) – Font size as percentage relative to image 

height.
– Absolute (dots) – Font size as absolute value in pixels.

Background

– Color Setting the background color.

– Transparency Setting the background transparency.

Preview Preview of the footer with the selected settings.
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… Continuation: Configuring Save buttons

Inscription tab for the logo The following figure shows the Save Settings dialog 
window with the Inscription tab and the settings for a logo 
within the image:

The following table contains information on the settings of 
the logo in the Inscription tab:

Component Function

Enabled Activating/deactivating the logo within the image.

Position Selection of a predefined position of the logo within the image.

Height (text rows) Setting the logo height in text rows.
The height of a text row always depends on the font size that has 
been set in the Height field of the footer settings.

Margin Activating/deactivating the logo distance from the image frame and/
or the footer text.

File Name Selecting the logo file’s saving location.
Displays the path of the selected saving location.
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Configuring live overlay

Description Live overlay shows parameters in the header and/or footer 
of the image acquisition window. The parameters dis-
played and the formatting of header and footer may be 
configured.

Live Overlay Settings For opening the Live Overlay Settings dialog window:

1. Click Preferences... in the File menu.
2. Click Configure Live Overlay… in the General tab.

General settings The general settings in the Live Overlay Settings dialog 
window may be entered regardless of the chosen tab.

The following table contains information on the general 
settings in the Live Overlay Settings dialog window:

Component Function

Enable Overlay & 
Micron Bar

Activates/deactivates live overlay.
If live overlay is active, the Micron bar (image scale) will always be vis-
ible on the bottom right in the footer.

Parameters…
Page 63

Opens the Parameters dialog window for selecting, setting and 
inserting the global parameters for live overlay entries (header and 
footer).

Text

– Color Setting the text color.

– Font Setting the font.

– Anti Aliasing Activating/deactivating anti-aliasing.

– Height Setting the font size.

– Height selection list Setting the font size unit:
– Relative (% of Width/Height) – Font size as percentage relative to 

image width and image height.
– Relative (% of Height) – Font size as percentage relative to image 

height.
– Absolute (dots) – Font size as absolute value in pixels.

Background

– Color Setting the background color.

– Transparency Setting the background transparency.

Preview Preview of the live overlay with selected settings.

OK Closes the dialog window.
The settings are applied.

Cancel Closes the dialog window.
All settings are rejected.
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Continuation next page … 

Footer tab The following figure shows the Live Overlay dialog 
window with the Footer tab:

The following table contains information on the compo-
nents of the Footer tab:

Component Function

Text field For inserting and arranging the parameters in the footer.
Parameters are displayed symbolically as parameter name in curly 
brackets.
After the parameter name, within the curly brackets, the percentage 
of the parameter indentation (from left) may be inserted separated 
by a semicolon, e. g.: 
– {Description;x=35} – This parameter would be indented to the left 

by 35% of the total image width in the footer.
– {Description;x=100} – This parameter would be aligned in the 

footer to the right-hand margin of the image.
Between parameters, any text (including special characters or 
breaks) may be inserted.
On the bottom right in the footer, the Micron bar showing the scale 
of the image will always be displayed.
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Header tab The following figure shows the Live Overlay Settings 
dialog window with the Header tab:

The following table contains information on the compo-
nents of the Header tab:

Component Function

Text field For inserting and arranging the parameters in the header.
Parameters are displayed symbolically as parameter name in curly 
brackets.
After the parameter name, within the curly brackets, the percentage 
of the parameter indentation (from left) may be inserted separated 
by a semicolon, e. g.: 
– {Description;x=35} – This parameter would be indented to the left 

by 35% of the total image width in the header.
– {Description;x=100} – This parameter would be aligned in the 

header to the right-hand margin of the image.
Between parameters, any text (including special characters or 
breaks) may be inserted.

Transparent Activates/deactivates the background color of the header.
If the checkbox is activated, the header background color is turned 
off (100% transparent).
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… Continuation: Configuring live overlay

Logo tab The following figure shows the Live Overlay Settings 
dialog window with the Logo tab:

The following table contains information on the compo-
nents of the Logo tab:

Component Function

Enabled Activates/deactivates the logo within the image.

Position Selection of a predefined position of the logo within the image.

Height (text rows) Setting the logo height in text rows.
This means, the height of a text row always depends on the font size 
that has been set in the Height field of the general settings.

Margin Activates/deactivates the logo’s distance to the image frame and/or 
footer text.

File Name Selecting the logo file’s saving location.
Displays the path of the selected saving location.
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Configuring parameters

Description In addition to the image data, meta data in XMP format will 
be saved with each image acquired in DISS 6. These meta 
data include information like image comment, acquisition 
date or magnification.

Meta data in XMP format may be displayed and processed 
with XMP-compatible image processing software.

These meta data may be displayed as live overlay, as footer 
in the saved image or as hint in the image preview and may 
be used for the automatic assignment of file names.

In the Parameters dialog window, the parameters to be dis-
played and their format may be configured.

Parameters dialog window The Parameters dialog window may be opened via the fol-
lowing windows:

– Live Overlay Settings (see Page 59)
– Hint Settings (see Page 47)
– Save Settings (see Page 53)

The following figure shows the Parameters dialog window 
with the following components:
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The following table contains information on the compo-
nents of the Parameters dialog window:

Component Function

Parameter list – Contains all available preconfigured parameters.
– Parameters may be selected by clicking them.
– By double-clicking, parameters may be inserted in the parameter 

list.

Alias Value Shows name and attributes of the selected parameter in XMP for-
mat.
Name and each single attribute will be separated by semicolons.

Value Type Changes the default data type of the selected parameter.
[default] maintains the default data type of the selected parameter.

Generally, [default] may be used for the Value Type.

Format Changes the display format of the parameter.
For example: The display of the acquisition time is to be changed 
from the preconfigured default format (d.m.yy h:nn:ss) including date 
and time to only display the date.
Select the parameter “AcquisitionTime” in the parameter list and 
enter the following value in the Format field: dd.mm.yyyy
 Thus, only the date will be displayed. Days and months will alway 

be displayed with two digits, years with four digits, for instance 
13.05.2024.

Unit Conversation Sets the automatic conversion of units:

–  Maintain default.
–  Enable unit conversion.
–  Disable unit conversion.

More… Opens a dialog window for displaying and adapting the changed 
parameter properties.

OK Closes the dialog window, the settings for the selected parameter 
are applied.

The selected parameter will not be inserted in the parameter list.

Add Inserts the selected parameter into the parameter list.

Cancel Closes the dialog window, the settings for the selected parameter 
are rejected.
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5.3 Functions in the Info menu

Overview

Purpose This section contains descriptions on the structure and 
function of the Info menu components.

Contents This sections contains the following information:

› About… . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66
› Environment…. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67
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About…

Description The About function opens a dialog window with product in-
formation on the version of the installed image acquisition 
software as well as the connected image acquisition elec-
tronics.

Dialog window The following figure shows the About dialog window:
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Environment…

Description The Environment function opens a dialog window which 
shows the saving locations of the configuration files and in-
stalled plug-ins.

The savings locations may not always be the same but in-
stead depend on the operation system. The Environment 
dialog window shows the saving locations’ paths.

Configuration Files tab The Configuration Files tab shows the saving locations of all 
configuration files.

Plugins tab The Plugins tab shows all currently loaded plug-ins includ-
ing their version numbers.



Image acquisition Functions in the Info menu

point electronic GmbH DISS 6 Software 68 / 206

Version: 6.4.0.0 Reference guide 26.02.2025

… Continuation: Environment…

Opening a configuration
file

Complete the following steps to open the configuration 
files or savings locations:

1. Switch to the Configuration Files tab in the Environ-
ment dialog window.

2. Click an item within the configuration file list to select 
it.

3. Click this item with the right mouse button and select 
the needed function in the context menu.

Configuring a plug-in Complete the following steps to configure a plug-in:

1. Switch to the Plugins tab in the Environment dialog 
window.

2. Click the needed plug-in in the list to select it.
3. Click the cog icon.

 A dialog window for configuring the selected plug-
in opens.
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5.4 Toolbar functions

Overview

Purpose This section contains descriptions on the structure and 
function of the toolbar elements.

Contents This sections contains the following information:

› Region Scan. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
› Live Scan . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73
› Slow Scan  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77
› Counter Scan. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81
› Line scan / point measurement . . . . . . . . . . . . . . . . . . . 85
› Measurement tools in line scan/point measurement  . . 95
› Beam positioning  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102
› Stop . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103
› TIFF Recorder (optional) . . . . . . . . . . . . . . . . . . . . . . . 104
› Video Recorder (optional) . . . . . . . . . . . . . . . . . . . . . . 106
› Signal Monitor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 115
› Channel Mixer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 117
› Save . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 121
› Fast Save . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 122
› Auto Save  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123
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Region Scan

Description Region scan is a fast continuous scan of a selected image 
area. Among other things, it is suitable for setting the fo-
cus.

Region scan may be started in an acquired live or slow scan 
image.

By pressing the region scan button, a scan will be started 
within the size of the displayed selection box.

The size of the selection box may be rescaled by changing 
its frame with the mouse or via scan settings.

Zoom function Region scan contains a Zoom function.

The image in the selected area may be zoomed in and out 
with the mouse wheel.

Button Pressing the following button initializes a region scan:

Cancel Region scan will be canceled when the Stop button or an-
other scan button is pressed.

Set-up of region scan A right-click on the region scan button opens the Scan Set-
tings dialog window to set up the relevant parameters.
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Scan Settings The following figure shows the Scan Settings dialog 
window with the following components:

The following table contains information on the compo-
nents of the Scan Settings dialog window:

Component Function

Title bar Displays the calculated scan time per frame based on the scan set-
tings.

Fast A
Fast B
Slow

Contain checkboxes for selecting an analog input signal source.

Use Image Channel The input channel of the ROI uses the input of the image on which it 
is applied if the checkbox is activated.

Dimensions

– Width Sets the width of a displayed image in pixels.
Depending on the aspect ratio selected in the Ratio field, any entry 
in the Width field leads to an automatic change of the Height value.

– Ratio Sets the aspect ratio of the displayed image.
The available values are 1:1, 5:4, 4:3 and Any.

– Height Sets the height of a displayed image in pixels.
Depending on the aspect ratio selected in the Ratio field, any entry 
in the Height field leads to an automatic change of the Width value.

Speed
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– Acq Time Sets the acquisition time per pixel.
The value may be set manually within a 10 ns grid.
Thus, the signal-to-noise ratio (SNR) may be improved. The acquisi-
tion time may be changed by using the [left arrow] and [right arrow] 
keys.

– Line Avg. Activates line averaging.
This means that each line is repeatedly scanned with a preset amount 
of scans. Image signals per line are shown averaged.

The use of line averaging is not possible if line synchronization is 
activated.

– Frame Avg Activates frame averaging.
This means that images are shown averaged by a preset frame rate. 
Frame averaging may be changed by using the [arrow up] and [arrow 
down] keys.

Synchronization

– Line Activates line synchronization.
With every new line, the scan is synchronized to the mains voltage in 
order to reduce interferences.

The use of line synchronization is not possible if line averaging is 
activated.

– Frame Activates image synchronization.
With every new image, the scan is synchronized to the mains voltage 
in order to reduce interferences.

Toolbar button – Selecting the Scan button to be shown in the toolbar.
– Entering a name to be displayed below the Scan button.

OK Closes the dialog window.
The preset parameters are saved.

Cancel Closes the dialog window.
The preset parameters are rejected.

Component Function
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Live Scan

Description Live scan is a fast, continuous scan exclusively intended for 
image preview.

The images displayed in the live scan cannot be saved.

The display size of the image may be rescaled by changing 
the frame with the mouse or via scan settings.

In the live scan, the amount of pixels of the displayed im-
age corresponds to the amount of scanned pixels.

Full screen mode Full screen mode can be activated by double-clicking the 
live scan image. In this mode, the image is only scanned 
with half the displayed pixels.

Example image resolution of 1024 × 768: 
If the full screen mode is activated, the image will be 
scanned with a resolution of 512 × 384 pixels.

For smoothing the image, use the key combination 
[Ctrl]+[I] to switch to an interpolated display.

Button Pressing the following button starts a live scan:

Cancel Live scan will be canceled when the Stop button or another 
scan button is pressed.
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Set-up of live scan A right-click on the live scan button opens the Scan Set-
tings dialog window to set up the relevant parameters.

Scan Settings The following figure shows the Scan Settings dialog 
window with the following components:

The following table contains information on the compo-
nents of the Scan Settings dialog window:

Component Function

Title bar Displays the calculated scan time per frame based on the scan set-
tings.

Fast A
Fast B
Slow

Contain checkboxes for selecting an analog input signal source.

Dimensions

– Width Sets the width of a displayed image in pixels.
Depending on the aspect ratio selected in the Ratio field, any entry 
in the Width field leads to an automatic change of the Height value.
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– Ratio Sets the aspect ratio of the displayed image.
The available values are 1:1, 5:4, 4:3 and Any.

– Height Sets the height of a displayed image in pixels.
Depending on the aspect ratio selected in the Ratio field, any entry 
in the Height field leads to an automatic change of the Width value.

Speed

– Acq Time Sets the acquisition time per pixel.
The value may be set manually within a 10 ns grid.
Thus, the signal-to-noise ratio (SNR) may be improved. The acquisi-
tion time may be changed by using the [left arrow] and [right arrow] 
keys.

– Line Avg Activates line averaging.
This means that each line is repeatedly scanned with a preset amount 
of scans. Image signals per line are shown averaged.

The use of line averaging is not possible if line synchronization is 
activated.

– Frame Avg Activates frame averaging.
This means that images are shown averaged by a preset frame rate. 
Frame averaging may be changed by using the [arrow up] and [arrow 
down] keys.

– Frame Count Sets the frame count.

Synchronization

– Line Activates line synchronization.
With every new line, the scan is synchronized to the mains voltage in 
order to reduce interferences.

The use of line synchronization is not possible if line averaging is 
activated.

– Frame Activates image synchronization.
With every new image, the scan is synchronized to the mains voltage 
in order to reduce interferences.

Brightness/Contrast 
Automatic

Regulates the brightness/contrast ratio of analog image signals.

– Enabled Activates the brightness/contrast automatic.

– Cut Off (%) The percentage of the brightest and darkest pixels set in the Cut Off 
field will not be included in the calculation of brightness and contrast 
to ignore outliers.

Display Options

– Hair Cross Shows a hair cross for adjustment of the grid in the center of the 
image.

– Clipping Indicator Activates/deactivates the display of an overdriven image signal.
If the checkbox is ticked, all absolutely white pixels will be displayed 
in red and all absolutely black pixels will be displayed in green.

Component Function
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Toolbar Button – Selecting the scan button to be shown in the toolbar.
– Entering a name to be displayed below the scan button.

OK Closes the dialog window.
The preset parameters are saved.

Cancel Closes the dialog window.
The preset parameters are rejected.

Component Function
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Slow Scan

Description Slow scan is used for the simultaneous image acquisition 
from up to four analog signal sources.

The display size of the images may be rescaled by changing 
the frame with the mouse.

The image resolution is set in scan settings. The number of 
scanning cycles may also be set in scan settings.

Images simultaneously acquired from several sources are 
displayed in a multi-divided window.

Button Pressing the following button starts a slow scan:

Ending The following table contains information on ending the 
slow scan and the corresponding actions:

Cancel Slow scan will be canceled when the Stop button or an-
other scan button is pressed.

Set-up of slow scan A right-click on the slow scan button opens the Scan Set-
tings dialog window to set up the relevant parameters.

Ending Action

At the end of a scan When the preset amount of 
scans is reached.

At the end of the current image 
rolling

After repeated pressing of the 
Slow Scan button.
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Scan Settings The following figure shows the Scan Settings dialog 
window with the following components:

The following table contains information on the compo-
nents of the Scan Settings dialog window:

Component Function

Title bar Displays the calculated scan time per frame based on the scan set-
tings.

Fast A
Fast B
Slow

Contain checkboxes for selecting analog input signal sources.

Dimensions

– Width Sets the width of a displayed image in pixels.
Depending on the aspect ratio selected in the Ratio field, any entry in 
the Width field leads to an automatic change of the Height value.

– Ratio Sets the aspect ratio of the displayed image.
The available values are 1:1, 5:4, 4:3 and Any.
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– Height Sets the height of a displayed image in pixels.
Depending on the aspect ratio selected in the Ratio field, any entry in 
the Height field leads to an automatic change of the Width value.

Speed

– Acq Time Sets the acquisition time per pixel.
The value may be set manually within a 10 ns grid.
Thus, the signal-to-noise ratio (SNR) may be improved. The acquisi-
tion time may be changed by using the [left arrow] and [right arrow] 
keys.

– Line Avg Activates line averaging.
This means that each line is repeatedly scanned with a preset amount 
of scans. Image signals per line are shown averaged.

The use of line averaging is not possible if line synchronization is 
activated.

– Frame Avg Activates frame averaging.
This means that images are shown averaged by a preset frame rate. 
Frame averaging may be changed by using the [arrow up] and [arrow 
down] keys.

– Frame Count Sets the frame count.

Synchronization

– Line Activates line synchronization.
With every new line, the scan is synchronized to the mains voltage in 
order to reduce interferences.

The use of line synchronization is not possible if line averaging is 
activated.

– Frame Activates image synchronization.
With every new image, the scan is synchronized to the mains voltage 
in order to reduce interferences.

Brightness/Contrast
Automatic

Regulates the brightness/contrast ratio of analog image signals.

– Options – Off: Deactivates the brightness/contrast automatic.
– Single: Brightness/contrast minimum and maximum will be deter-

mined for each image signal and applied accordingly.
– Global: Brightness/contrast minimum and maximum will be deter-

mined for each image signal. The resulting minima and maxima will 
be applied to all image signals to keep the image signal ratio.

– Cut Off (%) The percentage of the brightest and darkest pixels set in the Cut Off 
field will not be included in the calculation of brightness and contrast 
to ignore outliers.

Display Options

– Hair Cross Shows a hair cross for adjustment of the grid in the center of the 
image.

Component Function
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Toolbar Button – Selecting the scan button to be shown in the toolbar.
– Entering a name to be displayed below the scan button.

OK Closes the dialog window.
All preset parameters are saved and used for the next scanning pro-
cess.

Cancel Closes the dialog window.
The preset parameters are rejected.

Component Function
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Counter Scan

Description The counter scan is used for image acquisition of digital 
mapping images and analog signal sources. It is possible to 
acquire images simultaneously from up to twelve digital 
and up to four analog signal sources (optional).

The display size of the images may be rescaled by changing 
the frame with the mouse or via scan settings.

Image resolution and measure time of the images to be 
scanned may be set in scan settings.

Images simultaneously acquired from several sources are 
displayed in a multi-divided window.

Button Pressing the following button initializes a counter scan:

Ending The following table contains information on ending the 
counter scan and the corresponding actions:

Cancel Counter scan will be canceled when the Stop button or an-
other scan button is pressed.

Ending Action

At the end of a scan When the preset amount of 
scans is reached.

At the end of the current image 
rolling

By repeated pressing of the 
Counter button.
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Set-up of counter scan A right-click on the counter scan button opens the Scan 
Settings dialog window to set up the counter scan parame-
ters.

Scan Settings The following figure shows the Scan Settings dialog 
window with the following components:

The following table contains information on the compo-
nents of the Scan Settings dialog window:

Component Function

Title bar Displays the calculated scan time per frame based on the scan set-
tings.

Fast A
Fast B
Slow

Contain checkboxes for selecting analog input signal sources.

Counter Contain checkboxes for selecting up to twelve digital input signal 
sources.

Dimensions
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– Width Sets the width of a displayed image in pixels.
Depending on the aspect ratio selected in the Ratio field, any entry in 
the Width field leads to an automatic change of the Height value.

– Ratio Sets the aspect ratio of the displayed image.
The available values are 1:1, 5:4, 4:3 and Any.

– Height Sets the height of a displayed image in pixels.
Depending on the aspect ratio selected in the Ratio field, any entry in 
the Height field leads to an automatic change of the Width value.

Speed

– Acq Time Sets the acquisition time per pixel.
The value may be set manually within a 10 ns grid.
Thus, the signal-to-noise ratio (SNR) may be improved. The acquisi-
tion time may be changed by using the [left arrow] and [right arrow] 
keys.

– Frame Count Sets the frame count.

Counter Accumulation Counter Accumulation is used to add up the impulses at each pixel 
for the set number of line repetitions.

– Frame Activates/deactivates Counter Accumulation.

– Line Sets the number of line repetitions.

Synchronization

– Line Activates line synchronization.
With every new line, the scan is synchronized to the mains voltage in 
order to reduce interferences.

– Frame Activates image synchronization.
With every new image, the scan is synchronized to the mains voltage 
in order to reduce interferences.

Brightness/Contrast 
Automatic

Regulates the brightness/contrast ratio of image signals.

– Analog Contains options for brightness/contrast automatic of the analog 
image signals (see Options).

– Counter Contains options for brightness/contrast automatic of the digital 
image signals (see Options).

– Options – Off: Deactivates the brightness/contrast automatic.
– Single: Brightness/contrast minimum and maximum will be deter-

mined for each image signal and applied accordingly.
– Global: Brightness/contrast minimum and maximum will be deter-

mined for each image signal. The resulting minima and maxima will 
be applied to all image signals to keep the image signal ratio.

Component Function
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– Cut Off (%) The percentage of the brightest and darkest pixels set in the Cut Off 
field will not be included in the calculation of brightness and contrast 
to ignore outliers.
This percentage may be set differently for analog and digital image 
signals.

Display Options

– Hair Cross Shows a hair cross for adjustment of the grid in the center of the 
image.

– Clipping Indicator Activates/deactivates the display of an overdriven image signal.
If the checkbox is ticked, all absolutely white pixels will be displayed 
in red and all absolutely black pixels will be displayed in green.

Toolbar Button – Selecting the scan button to be shown in the toolbar.
– Entering a name to be displayed below the scan button.

OK Closes the dialog window.
All preset parameters are saved and used for the next scanning pro-
cess.

Cancel Closes the dialog window.
The preset parameters are rejected.

Component Function
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Line scan / point measurement

Description The Line scan / point measurement function scans any line 
or point on the sample. 

Thus captured signals may be displayed graphically or ex-
ported as table.

Before a line scan may be started, a slow scan image has to 
be acquired and the magnification of the microscope has 
to be entered. Entering the magnification is not necessary 
for devices with automatic parameter transfer controlled by 
image acquisition.

Button Pressing the following button opens the Point/Line Mea-
surement dialog window to set up and to do line scans 
and/or point measurements:

Ending Function will be ended by closing the Point/Line Measure-
ment window.

NOTICE

No other scan function may be processed during activity 
of the line scan / point measurement function.
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User interface The following figure shows the Line Scan user interface with 
its main components:

The following table contains information on the main com-
ponents of the user interface of the Line Scan:

1

2

3

No. Component Function

1 Measurement tools Buttons for selection or creation of the following measuring objects:
– Horizontal measurement lines (Page 96)
– Free measurement lines (Page 97)
– Measurement points (Page 99)
– Measurement areas (Page 100)

2 Tabs

– Scan Contains functions to set up the scan (Page 88).

– Diagrams Contains functions to set up the diagram display (Page 90).

– Lines – Shows the values of the created measurement lines in a table.
– Modification of shown values.
– Contains checkboxes for activating/deactivating single measure-

ment lines for the Export Data... function.
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– Points – Shows the values of the created measurement points in a table.
– For changing the displayed values and deletion of the applied 

measurement points.
– Contains checkboxes for activating/deactivating single measure-

ment points for the Export Data... function.

– Areas – Shows the values of the created measurement areas in a table.
– For changing the displayed values and deletion of the applied 

measurement areas.
– Contains checkboxes for activating/deactivating single measure-

ment areas for the Export Data... function.

– Line Marks Shows the markers set in the diagram with their position and the 
measured value in a table.
Markers may be set in the diagram and deleted with a right-click.

Setting/deleting markers is only possible if the per Line option is 
activated in the Line/Diagram Assignment.

3 Function keys

– Start 
Acquisition

Starts the scanning process with the preset values.

– Stop 
Acquisition

Ends the scanning process.

– Save Graph… – Opens a dialog window for exporting the acquired image with 
measurement lines, measurement points and diagrams as TIFF file.

Additionally, the data export can be activated. Thus, the measuring 
object’s tables will be saved as XLS or CSV file with the same file 
name.

– Export Data… Opens a dialog window for exporting the line, point and area tables 
as XLS or CSV file.

– Save Table… Opens a dialog window for saving the currently displayed measuring 
object table.

Will only be displayed with the Points oder Lines, Areas and Line 
Marks tabs.

– Close Closes the dialog window.
The scan is canceled, all settings are rejected.

No. Component Function
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Scan tab The following figure shows the Scan tab with its compo-
nents:

The following table contains information on the compo-
nents of the Scan tab:

Component Function

Analog Contain checkboxes for selecting up to four analog input signal 
sources.

Counter Contains checkboxes for selecting up to twelve digital input signal 
sources.

Scanning Parameters Contains global settings for line scan / point measurement.

– Measure Time Sets the measure time of the mapping counters.
During that time, digital image signals for each pixel are accumu-
lated.

– Subpixels Contains a selection of possible subpixel ranges that may addition-
ally be measured around each measuring point.

If a subpixel range larger than 1 × 1 is selected, the measuring 
points will be displayed as squares instead of crosses if the Show 
Points function is activated.

– Overall Time Displays the calculated scan time based on the scan settings.
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Object Properties Contains settings of the currently selected measuring object.

– Show Points Activates or deactivates the display of measurement points on the 
selected measuring object.
– All activates the display for all measuring objects created.
– None deactivates the display for all measuring objects created.

If the display is activated, the measuring points will be displayed 
as crosses.

– Show Label Activates or deactivates the display of the numbering of the selected 
measuring object.
– All activates the display for all measuring objects created.
– None deactivates the display for all measuring objects created.

– Export Object Activates or deactivates the Export Data function of the selected 
measuring object.
– All activates the export for all measuring objects created.
– None deactivates the export for all measuring objects created.

Scan Resolution – Contains functions for scan resolution set-up within the Object 
Properties.

– The scan resolution is defined by the amount of measurement 
points for the currently selected measuring object.

– From Image The scan resolution for the currently selected measuring object con-
forms with the resolution of the current image in pixels.

– Point Distance Direct input (in µm) of the distance between the measurement points 
of the currently selected measuring object in the input field.

– Point Count Direct input of the amount of measurement points for the currently 
selected measuring object in the input field.

– All Applies the set value for Point Distance and/or Point Count to all mea-
suring objects.

Component Function
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Diagrams tab The following figure shows the Diagrams tab with its com-
ponents:

The following table contains information on the compo-
nents of the Diagrams tab:

1

2

3

No. Component Function

1 Diagram display Shows diagrams for created measurement lines on the basis of values 
set in the Diagrams tab.

2 View switch Enlarges or reduces the diagram view in the dialog window.

Line/Diagram 
Assignment

Contains functions to display input signal sources in one or multiple 
diagrams.
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– One Diagram All input signal sources will be displayed in one diagram.

– Individual 
(Page 94)

Individual display of the input signal sources in one or multiple dia-
grams.
In the Lines field, the individual input signal sources may be 
attributed to the individual diagrams.

– per Line For each created measurement line, a diagram which shows all con-
tained input signal sources will be generated.

In this view, markers (line marks) may be set in a diagram or 
deleted from it by right-click.

– per Signal Each input signal source will be displayed in a diagram.

3 Lines – Contains specifications for all created measurement lines.
– Distributes input signal sources to different diagrams.

– L – Activates or deactivates measurement lines.
– Only shown if several measurement lines were applied.

– Input Contains the created measurement lines and the corresponding 
input signal sources.

– Show Activates or deactivates input signal sources.

– Signal Contains the elements of the input signal sources as comment.

– Color – Shows the current color for each measurement line.
– Sets a color for each measurement line.

Smoothing Contains functions to smooth the signal curve(s) in the diagram.

– None No smoothing of the signal curve(s).

– Moderate Normal smoothing of the signal curve(s).

– Light Light smoothing of the signal curve(s).

– Heavy Intense smoothing of the signal curve(s).

Y-Scaling Contains functions on setting the diagram scaling in Y direction.

– Peak The scaling of individual diagrams ends at the maximum value of the 
contained input signal source.

– Selected Signal 
(Page 93)

The scaling of all displayed diagrams follows one selected input sig-
nal source.

– Equal 
(Page 93)

Manual setting of scaling for all displayed diagrams.
The lowest and the highest value of the Y axis may be set. The sec-
tioning of the Y axis will be calculated automatically.

– Individual 
(Page 94)

Manual setting of scaling for each displayed diagram.
For each diagram, the lowest and the highest value of the Y axis may 
be set. The sectioning of the Y axis will be calculated automatically.

– Zero Basis If the checkbox is activated, scaling of all diagrams starts at zero.

No. Component Function
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Line/Diagram Assignment –
Individual

The following figure shows a detail of the Diagrams tab 
with the components of the Line/Diagram Assignment – In-
dividual function:

The following table contains information on the 
components of the Line/Diagram Assignment – Individual 
function:

No. Component Function

1 Diagram assignment distribution and/or combination 
of the input signal sources in dif-
ferent diagrams.

1
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Y-Scaling – Selected Signal The following figure shows a detail of the Diagrams tab 
with the components of the Y-Scaling – Selected Signal 
function:

The following table contains information on the compo-
nents of the Y-Scaling – Selected Signal function:

Y-Scaling – Equal The following figure shows a detail of the Diagrams tab 
with the components of the Y-Scaling – Equal function:

The following table contains information on the compo-
nents of the Y-Scaling – Equal function:

Component Function

Signal Defines the preferred input signal source to whose 
amplitude the scaling of all displayed diagrams will 
conform.

Component Function

Low Sets the lowest scale interval for all diagrams.

High Sets the highest scale interval for all diagrams.

Divide Sets the scale divider for all diagrams.
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Y-Scaling – Individual The following figure shows a detail of the Diagrams tab 
with the components of the Y-Scaling – Individual function:

The following table contains information on the compo-
nents of the Y-Scaling – Individual function:

Component Function

Diagrams Contains functions on setting the diagram scaling in Y direction.

– Name – Contains all created measurement lines when the function Line/
Diagram Assignment – per Line is activated.

– Contains all input signal sources when the function Line/Diagram 
Assignment – per Signal is activated.

– Low Sets the lowest scale interval for each measurement line or input sig-
nal source.

– High Sets the highest scale interval for each measurement line or input 
signal source.

– Divide Sets the scale divider for every diagram.
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Measurement tools in line scan/point 
measurement

Description In a captured slow scan image, different measurement 
points, measurement lines and measurement areas may be 
determined.

After clicking the Start Acquisition button, the scan will 
be carried out on exactly these determined positions.

Measurement tools The following table contains an overview of the measure-
ment tools in the Point/Line Measurement dialog window:

Measurement 
tool

Function

Selection of created measurement lines, mea-
surement points and measurement areas.

Creation of horizontal measurement lines in an 
acquired image (Page 96).

Creation of free measurement lines in an 
acquired image (Page 97).

Creation of measurement points in an acquired 
image (Page 99).

Creation of rectangular measurement areas in 
an acquired image (Page 100).
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Creation of horizontal
measurement lines

In the image acquisition window, horizontal lines that cross 
the whole scan with a 0° angle from left to right will be cre-
ated. The arrow indicates the measurement direction.

The following table contains information on options for cre-
ating and changing horizontal measurement lines:

SE 0%X: 20,00 μm Y: 26,00 μm D: 36,77 μm

SE

750x | Pix: 9,071 nm

1,505 mm | 1,003 mm

300 μm

Comment

Slow Scan @ 100,0%

Measurement line … Steps

Creation – Click the tool for horizontal measurement lines in the Point/Line 
Measurement dialog window.

– Click into the image acquisition window.
 A horizontal measurement line will be created.

Selection Use the selection tool to click the particular measurement line in the 
image acquisition window.
 The measurement line is selected and highlighted in red.

Moving – Select the particular measurement line.
– Click the selected measurement line and keep the mouse button 

pressed while moving the line.

Copy – Select the particular measurement line.
– Keep the [Ctrl] key pressed, click the selected measurement line 

and keep the mouse button pressed while moving the line.
 During moving, the measurement line will be copied.
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The values of the created measurement lines (e. g. coordi-
nates, length, angle) may be read and changed in the Lines 
tab in the Point/Line Measurement dialog window. In this 
tab, several measurement lines may also be selected by 
clicking them while keeping the [Ctrl] or [Shift] key pressed 
and may then be deleted with the [Del] key.

Creation of free
measurement lines

In the image acquisition window, free measurement lines of 
any length, direction and angle may be created. The arrow 
indicates the measurement direction.

Deletion – Select the particular measurement line.
– Press the [Del] key.

 The selected measurement line will be deleted.

Measurement line … Steps

SE 0%X: 20,00 μm Y: 26,00 μm D: 36,77 μm

SE

750x | Pix: 9,071 nm

1,505 mm | 1,003 mm

300 μm

Comment

Slow Scan @ 100,0%
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The following table contains information on options for cre-
ating and changing free measurement lines:

The values of the created measurement lines (e. g. coordi-
nates, length, angle) may be read and changed in the Lines 
tab in the Point/Line Measurement dialog window. In this 
tab, several measurement lines may also be selected by 
clicking them while keeping the [Ctrl] or [Shift] key pressed 
and may then be deleted with the [Del] key.

Measurement line … Steps

Creation – Click the tool for free measurement lines in the Point/Line Mea-
surement dialog window.

– Click into the image acquisition window to set the zero point of the 
free measurement line.

– Click again into the image acquisition window to set the final point 
of the free measurement line.
 The free measurement line is created. Measurement direction 

will be indicated by an arrow. Measurement will always take 
place from zero to final point.

Selection Use the selection tool to click the particular measurement line in the 
image acquisition window.
 The measurement line is selected and highlighted in red.

Change – Select the particular measurement line.
– Click the zero or final point of the selected measurement line and 

keep the mouse button pressed while moving it.

Zero and final points of selected measurement lines will be high-
lighted with little circles when moving the mouse cursor over 
them.

Creation with determined 
angle

Keep the [Ctrl] key pressed to lock the line angle in 45° steps while 
completing one of the following actions:
– determining the final point of a free measurement line.
– moving the zero point or final point of a selected free measure-

ment line.

Moving – Select the particular measurement line.
– Click the selected measurement line and keep the mouse button 

pressed while moving the line.

Copy – Select the particular measurement line.
– Keep the [Ctrl] key pressed, click the selected measurement line 

and keep the mouse button pressed while moving the line.
 During moving, the measurement line will be copied.

Deletion – Select the particular measurement line.
– Press the [Del] key.

 The measurement line will be deleted.
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Creation of measurement
points

Creates measurement points in the image acquisition win-
dow.

The following table contains information on options for cre-
ating and changing measurement points:

SE 0%X: 20,00 μm Y: 26,00 μm D: 36,77 μm

SE

750x | Pix: 9,071 nm

1,505 mm | 1,003 mm

300 μm

Comment

Slow Scan @ 100,0%

Measurement point … Steps

Creation – Click the tool for measurement points in the Point/Line Measure-
ment dialog window.

– Click into the image acquisition window.
 A measurement point will be created.

Selection Use the selection tool to click the particular measurement point in 
the image acquisition window.
 The measurement point is selected and highlighted in red.

Moving – Select the particular measurement point.
– Click the selected measurement point and keep the mouse button 

pressed while moving it.

Deletion – Select the particular measurement point.
– Press the [Del] key.

 The measurement point will be deleted.
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The values of the created measurement points (e. g. coor-
dinates) may be read and changed in the Points tab in the 
Point/Line Measurement dialog window. In this tab, sev-
eral measurement points may also be selected by clicking 
them while keeping the [Ctrl] or [Shift] key pressed and may 
then be deleted with the [Del] key.

Creation of rectangular
measurement areas

Creates rectangular measurement areas of any size in the 
image acquisition window.

The following table contains information on options for cre-
ating and changing rectangular measurement areas:

SE 0%X: 20,00 μm Y: 26,00 μm D: 36,77 μm

SE

750x | Pix: 9,071 nm

1,505 mm | 1,003 mm

300 μm

Comment

Slow Scan @ 100,0%

1

2

3

Measurement area … Steps

Creation – Click the tool for rectangular measurement areas in the Point/Line 
Measurement dialog window.

– Click into the image acquisition window to determine the upper 
left corner of the measurement area.

– Click again into the image acquisition window to determine the 
bottom right corner of the measurement area.
 The rectangular measurement area will be created.
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The values of the applied measurement areas (e. g. coordi-
nates) may be read and changed in the Area tab in the 
Point/Line Measurement dialog window. In this tab, sev-
eral measurement areas may also be selected by clicking 
them while keeping the [Ctrl] or [Shift] key pressed and may 
then be deleted with the [Del] key.

Selection Use the selection tool to click the particular measurement area in the 
image acquisition window.
 The measurement area is selected and highlighted in red.

Change – Select the particular measurement area.
– To change height and width at the same time, click one of the cor-

ners of the selected measurement area. Keep the mouse button 
pressed while moving the corner.

– To change either height or width, click one of the edges (between 
2 corners) of the selected measurement area. Keep the mouse but-
ton pressed while moving the edge.

The corners of the selected measurement area will be highlighted 
with little circles when moving the mouse cursor over them.

Deletion – Select the particular measurement area.
– Press the [Del] key.

 The measurement area will be deleted.

Measurement area … Steps
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Beam positioning

Description Beam positioning allows to position the electron beam on 
the sample.

Button Beam positioning may be started and ended with the fol-
lowing button:

Positioning of the electron
beam

Complete the following steps to position the electron 
beam on the sample:

4. Perform a slow scan.
5. Click the button in the Image acquisition toolbar to 

start Beam positioning.
 The mouse cursor will change when placed in the 

image acquisition window.
6. Click on any position in the image acquisition window.

 The electron beam will be placed on the corre-
sponding position on the sample.

Cancel Beam positioning will be canceled when the button in the 
Image acquisition toolbar, the Stop button or any other 
scan button is pressed.
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Stop

Description With the stop function, the various scan modes may be can-
celed.

Button The scanning process may immediately be canceled by 
pressing the following button:
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TIFF Recorder (optional)

Description The optional TIFF recorder plug-in records bitmaps in a 
continuous scan and saves them in a 8 Bit multipage TIFF 
file.

In the case of multiple channels, one TIFF file per channel 
will be created and saved.

Button Pressing the following button opens the TIFF Recorder 
window:

Dialog window The following figure shows the TIFF Recorder dialog 
window with the following components:

The following table contains information on the compo-
nents of the TIFF Recorder dialog window:

Component Function

Record Starts/ends the recording.

If the recording is stopped before reaching the set bitmap num-
ber, all TIFF files are saved with the bitmap number reached by 
the end of the recording.

Cancel Cancels the recording.
No TIFF files will be saved.

Image Path Display and selection of the saving location.

File Prefix Entering the prefix for the file name.

Frame Count Setting the number of bitmaps that will be saved in a multipage TIFF 
file.
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Recording Complete the following steps to record images with the 
TIFF recorder plug-in:

1. Start a continuous scan (Frame Count = 0).
2. Click the TIFF Recorder button.

 The TIFF Recorder dialog window opens.
3. Select the preferred saving location in the Image Path 

field.
4. Enter the preferred file name in the File Prefix field.
5. Enter the preferred number of bitmaps per multipage 

TIFF file in the Frame Count field.
6. Click the Record button.

 Recording starts. During the recording, the images 
will be saved in a TEMP folder. As soon as the num-
ber entered in the Frame Count field is reached, all 
TIFF files will be saved in the selected saving loca-
tion.

TIFF file name The TIFF files are saved with a file name that consists of the 
following elements:

Progress bar Shows the scanning progress.

Component Function

No. Description

1 Text entered in the File Prefix field.

2 Number of recorded TIFF files.

The numbers are counted starting from zero:

– 0000 = TIFF 1
– 0001 = TIFF 2
– …

3 Channel number.

The numbers are counted starting from zero:

– 0000 = Channel 1
– 0001 = Channel 2
– …

Prefix-0001-0000.tif

1 2 3
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Video Recorder (optional)

Description The optional video recorder plug-in acquires the shown im-
ages in a continuous scan and creates a video in H2g4 Co-
dec.

In the case of multiple channels, one video per channel will 
be created and saved.

The encoder bitrate may be configured in the file C:\Pro-
gramData\point electronic\DISS6\plug-ins\ui\Video-
Rec\VideoRec.ini.

Button Pressing the following button opens the Video Recorder 
dialog window:

Dialog window The following figure shows the Video Recorder dialog 
window with the following components:
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The following table contains information on the compo-
nents of the Video Recorder dialog window:

Recording Complete the following steps to record a video with the 
video recorder plug-in:

1. Start a continuous scan (Frame Count = 0).
2. Click the Video Recorder button.

 The Video Recorder window opens.
3. Select the preferred saving location in the Video Out-

put Folder field.
4. Enter the preferred file name in the Video Name field.
5. Manually enter the video frame rate in the Frame Rate 

field or activate the Acquisition Frame Rate checkbox 
to use the image acquisition frame rate.

6. Optional: Activate the Preview checkbox to show a live 
preview during encoding of the video.

7. Click the Record button to start the video recording.

Component Function

Video Output Folder Display and selection of the saving location.

Video Name Setting a file name for the video.

In the case of multiple channels, the chan-
nel number will be added to each video 
file name. The channel numbers are 
counted starting from zero:

– video_0000 = video of channel 1
– video_0001 = video of channel 2
– …

Frame Rate Manual setting of the video frame rate.

May only be used with deactivated check-
box Acquisition Frame Rate.

Acquisition Frame 
Rate

With activated checkbox, the image acquisi-
tion frame rate will be used for the video 
frame rate.

Preview Activates/deactivates a live preview of the 
video during encoding.

Record Starts/ends a video recording.

Pause Pauses/continues a video recording.

Abort Cancels a video recording.

Progress bar Shows the progress of the video encoding.

Status bar Shows the number of currently acquired 
frames and the status of the video recording.
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8. Click the Record button again to end the video re-
cording.
 The video will be encoded and saved at the se-

lected saving location.
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BSE Topography (optional)

Description In connection with a four-quadrant BSE signal source, the 
3D topography module allows for generation, visualization 
and export of a 3D surface model in Live mode.

The resolution of the calculated 3D model depends on the 
resolution of the SEM image data.

Supported formats The following formats are available for saving and export of 
the generated 3D data:

Button Pressing the following button opens the BSE Topography 
dialog window:

Format Data

Surface Data Format (*.sdf) Topography (3D model)

Alicona 3D (*.al3d) Topography (3D model) and BSE 
total (mean)

Tagged Image File Format (.tif) Topography (3D model) and BSE 
total (mean)

16 bit data, scaling will be 
saved in the XMP header

Windows Bitmap (.bmp) Topography (3D model)

Calibration file in ASCII format 
(*.cal)

Settings for corrections including 
respective correction values.
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User interface The following figure shows  the BSE Topography dialog 
window with its main components:

The following table contains information on  the main com-
ponents of the BSE Topography dialog window:

1

2

4

3

No. Component Function

1 3D view – Rotating the view with the mouse and pressed left mouse key.
– Shifting the view with the mouse and pressed right mouse key.
– Changing the zoom factor with the mouse wheel.
– Resetting the view by double-clicking.

2 Tabs

– View Contains settings for displaying the calculated surface model 
(Page 111).

– Settings Contains settings for scan and scale corrections (Page 112).

– Info Shows information on the installed 3D topography module 
(Page 114).

3 Field of View Shows the dimensions of the scan area.

4 Save…

View Saves the current 3D view in an image file.

Heights Saves the data of the calculated 3D model in a supported format 
(see “Supported formats” on page 109)
The saved data may be opened in a suitable application for further 
evaluation.
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View tab The following figure shows the BSE Topography window 
with the View tab:

The following table contains information on the compo-
nents of the View tab:

Component Function

Zoom Set-up of the zoom factor for the 3D view.

Scale Z Set-up of the scaling factor for the heights in the 3D view.
The setting will exclusively be used for the 3D view and will not be 
taken into account when saving the data.

Show Height Scale Activates or deactivates the display of the scale for the heights in the 
3D view.

Relative Heights Shows the height scale zero-based.

Texture Selection of the texture of the 3D view:
– None: no texture
– BSE mean image: texture value is the mean of all four channels
– BSE values: calculation of the backscatter value in consideration of 

topography
– Gradient norm: standardized gradient of the surface element as 

texture value
– Gradient direction: direction of the gradient as texture value
– Gradient x: gradient in x direction as texture value
– Gradient y: gradient in y direction as texture value

Color Table Selection of a color palette for the heights display in the 3D view.

View Mode Selection of the display mode for the rendering of the 3D view.

Lights Activates or deactivates the lighting for the rendering of the 3D view.
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Settings tab The following figure shows the BSE Topography dialog 
window with the Settings tab:

The following table contains information on the compo-
nents of the Settings tab:

Component Function

Scan Correction

– Auto Apply Scan Rotation Activates or deactivates the automatic reading of the current scan 
rotation.

The value of the scan rotation needs to be known for the correct 
calculation of the topography. 

This function should only be deactivated if automatic reading of 
the scan rotation is not possible.

– Scan Rotation – Shows the value of the scan rotation with activated Auto Apply 
Scan Rotation function.

– Manual entering of the value of the scan rotation with deactivated 
Auto Apply Scan Rotation function.

– Scan Correction Activates or deactivates scan correction.
This takes into account deviations of the electron beam off the per-
pendicular. These deviations are particularly common for acquisitions 
with low magnification.
Scan correction should always be activated.
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– Sphere Correction Activates or deactivates sphere correction.
This takes into account the decrease of backscatter intensity from the 
center point to the edge of the scan. This decrease leads to a spheri-
cal deviation in the height data.
Before activating the sphere correction, the radius of the spherical 
deviation needs to be determined or entered (particularly for acquisi-
tions with low magnification).

– Adjust Automatically determines the radius of the spherical deviation if a 
flat calibration sample is used.
This automatic determination should be performed before activating 
sphere correction.

– Sphere Radius Manual setting of the radius of the spherical deviation.
The manual setting is necessary whenever no automatic determina-
tion is performed.

Scale Correction

– Apply Scale Correction Activates or deactivates the use of indicated scales for the scale cor-
rection.
The indicated scales will be used for the 3D view and for saving the 
data.
The correction values of the scales have to be reloaded from a cali-
bration file after each modification of acquisition parameters or have 
to be determined again by a new calibration sample. 

– Scale X Set-up of the correction value for the X axis scale.

– Scale Y Set-up of the correction value for the Y axis scale.

– Scale Z Set-up of the correction value for the Z axis scale.

– Display of mcr file Shows the name of the loaded reference file (*.mcr)

Will only be displayed when a reference file has been loaded.

Selection and loading of the reference file for the calibration pyra-
mid.

– Adjust Automatically determines the correction values for the scales of all 
axes.
Before this automatic determination, it is necessary to:
1. insert a calibration pyramid in the sample chamber,
2. load the reference file for the calibration pyramid and
3. start an image acquisition with Slow Scan with 1000 x 1000 pixels 

and as little noise as possible.

Component Function
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Info tab The Info tab shows information on the installed version of 
the 3D topography module, the used driver packages as 
well as the software license:

Context menu A right-click within the tab opens a context menu with the following 
items:
– Save Settings: All settings will be saved in the device configuration.
– Load Calibration: Opens a dialog window for selection and loading 

of a calibration file with saved settings for the corrections and the 
respective correction values.

– Save Calibration: Opens a dialog window for saving the settings of 
the corrections and the respective correction values in a calibration 
file.

The Save Calibration function should be used if the task requires 
differing application settings, especially for SEM parameters (high 
voltage, aperture current, working distance).

Component Function
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Signal Monitor

Description The signal monitor shows the levels of the input signals 
during the scanning process in a separate window.

Button Pressing the following button opens the signal monitor:

Analog Signals tab The following figure shows the signal monitor with the An-
alog Signals tab:
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Histogram Tab The Histogram tab shows a live histogram as well as a spec-
ifications of the mean value and standard deviation.

The following figure shows the signal monitor with the His-
togram tab:
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Channel Mixer

Description Channel mixer allows to live-mix image signals. All image 
signals of the current active scan may be mixed. Each im-
age signal may be allocated a color.

Button Pressing the following button opens the channel mixer:

Merge tab In the Merge tab, all image signals of the active scan may be 
dyed and mixed.

The following figure shows the Channel Mixer dialog win-
dow with the Merge tab:

1

2

3

4
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The following table contains information on the compo-
nents of the Merge tab:

No. Component Function

1 Threshold color Shows the color that symbolizes a channel in the mixer.
By clicking the color, b/w and color mode may be switched. In color 
mode, a right-click opens a dialog window for choosing colors.

2 Slider Sets channel intensity.

3 Checkbox Activates or deactivates the channel.

4 Name Name of the channel.

Image Shows the result of the mixed images.
Double-clicking the image activates the full screen mode.
A right-click on the image opens a context menu (XREF context 
menu) with the following functions:
– Hair Cross
– Draw Circle
– Interpolation

Signal Name The text entered into the Signal Name text field determines the 
parameter “SignalName”.

Save Image... Opens the Save Image dialog window to save the mixed image as 
calibrated TIFF.
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Topo/Compo tab In the Topo/Compo tab, up to 4 image signals of analog sig-
nal sources can be added or subtracted. In the topo mode 
(subtraction), the balance of subtracted signals may be 
changed with a slider. With opposite BSE detectors, the 
material contrast may be minimized to a degree that only 
the topography of the sample is visible.

The following figure shows the Channel Mixer dialog win-
dow with the Topo/Compo tab:

The following table contains information on the compo-
nents of the Topo/Compo tab:

Component Function

Channel – Displays the available BSE signal sources.
– Defines which channel (-) is subtracted from which channel (+).

Balance Sets the ratio between the channels to be combined.

Offset Sets the brightness of the mixed image.

Gain Sets the contrast of the mixed image.

Bias Compensation Activates or deactivates the automatic brightness adaptation.

Signal Name The text entered into the Signal Name text field determines the 
parameter “SignalName”.

Save Image... Opens the Save Image dialog window to save the mixed image as 
calibrated TIFF.
For the footer, the settings of the Save button set as default will be 
applied (Page 49).



Image acquisition Toolbar functions

point electronic GmbH DISS 6 Software 120 / 206

Version: 6.4.0.0 Reference guide 26.02.2025

… Continuation: Channel Mixer

Reference image Reference images are used to compare image acquisition 
results. After completed image acquisition, an image may 
be added by Drag & Drop as reference image. It will be ar-
chived as “Ref” in the channel mixer.

The images (channels) of the next scan will be added to the 
reference image.

After completed image acquisition, the reference image 
may be deleted with the [Esc].
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Save

Description Use the Save function to save the currently acquired image 
or layout.

Button Pressing the following button opens the Save Image dialog 
window:

Configuring the function The Save function's parameters may be configured in the 
Save Settings dialog window. This dialog window may be 
opened as follows:

– By right-clicking the button.
– In the Parameters dialog window.

see “Configuring Save buttons” on page 53



Image acquisition Toolbar functions

point electronic GmbH DISS 6 Software 122 / 206

Version: 6.4.0.0 Reference guide 26.02.2025

Fast Save

Description The Fast Save function saves the currently acquired image 
or layout with an automatically assigned file name directly 
to a predefined saving location.

If the Auto File Name and Auto Folder fields of a Save button 
have been accordingly configured, this button will be acti-
vated as Fast Save in the toolbar.

Button By clicking the following button, the currently acquired im-
age or layout will be saved directly:

Configuring the function The Fast Save function's parameters may be configured in 
the Save Settings dialog window. This dialog window may 
be opened as follows:

– By right-clicking the button.
– In the Parameters dialog window.

see “Configuring Save buttons” on page 53
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Auto Save

Description The Auto Save function saves the currently acquired image 
or layout with an automatically assigned file name to a pre-
defined saving location after completion of the scanning.

The Auto Save function’s button may be activated or deac-
tivated in General tab of the Preferences dialog window.

Button Clicking the following button activates or deactivates the 
Auto save function:

Configuring the function The Auto save function’s parameter may be configured in 
the Save Settings dialog window. This dialog window may 
be opened as follows:

– By right-clicking the button.
– In the Parameters dialog window.

see “Configuring Save buttons” on page 53
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6 Optional control panels

Chapter overview

Purpose This section contains descriptions on the structure, function 
and usage of the optional control panels.

Contents This chapter contains the following sections:

› 6.1 BSE . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 125
› 6.2 Inspector . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 129
› 6.3 Project parameters . . . . . . . . . . . . . . . . . . . . . . . . 131
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6.1 BSE

Overview

Purpose This section contains descriptions on the structure and 
function of the optional BSE control panel.

Contents This sections contains the following information:

› Control panel. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 126
› Matching of individual channels . . . . . . . . . . . . . . . . . 128
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Continuation next page … 

Control panel

Description The BSE control panel sets brightness and contrast of a 
backscattered electron detector.

The BSE panel will only be displayed with the Multi Channel 
Signal Amplifier (MICS) hardware option.

Structure The following figure shows the BSE control panel with the 
following components:

Function The following table contains information on the BSE control 
panel components:

NOTICE

The name of the control panel depends on the active 
application!

If other detectors are used (e. g. CL), depending on the 
selected signal, the control panel may also be used for 
set-up of these signals.
Thus, the name of the panel may vary.

Adjust…AC

125

Gain

0,005

Input Offset (Low)
BSE

Component Function

Input Offset (Low) Set-up of the offset method by right-click on the label. The following 
offset methods are available:
– Input Offset: Complete setting range that may be necessary for 

very high offsets.

For input offset, brightness is set before gain. Thus, the sensitivity 
depends on the gain.

– Input Offset (Low): Attenuated setting range.
– Output Offset

 (Brightness) Global set-up of the brightness by slider or direct value input.

 (Contrast) Global set-up of the gain (contrast) by slider or direct value input.
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… Continuation: Control panel

AC Automatic contrast.
Sets the contrast automatically.

Adjust...
(Page 128)

Opens the Adjust Global Channels dialog window for matching the 
individual channels.
The set ratio will be used for the global set-up of brightness and con-
trast.

Component Function
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Matching of individual channels

Adjust Global Channels The Adjust Global Channels dialog window is used to set 
the brightness and contrast ratio of individual channels. 
The set ratio will be used for modifying brightness and con-
trast in the BSE control panel:

The following table contains information on the compo-
nents of the Adjust Global Channels dialog window:

Component Function

 (Brightness) Set-up of the brightness of a specific channel.

 (Contrast) Set-up of the gain (contrast) of a specific channel.

Input Offsets Performs an automatic zero balance.

Before the matching, electron beam and the chamber scope 
illumination need to be turned off.

Close Closes the dialog window.
All settings are saved.
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6.2 Inspector

Overview

Purpose This section contains descriptions on the structure and 
function of the optional Inspector control panel.

Contents This sections contains the following information:

› Control panel. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 130
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Control panel

Description The Inspector control panel shows the physical and digital 
values of the currently acquired signals at the position of 
the mouse.

For calculation of the physical values, a formula may be en-
tered.

Structure The following figure shows the Inspector control panel with 
the following components:

Function The following table contains information on the Inspector 
control panel components:

Inspector
SE -0,500 V (0)
InLens -0,500 V (0)
BSE 1 0,001 V (0)
BSE 2 0,002 V (0)
BSE 3 0,002 V (364)
BSE 4 0,003 V (339)

1

2

No. Function

1 Digital values

2 Physical values
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6.3 Project parameters

Overview

Purpose This section contains descriptions on the structure, function 
and configuration of the optional control panel
Project parameters.

Contents This sections contains the following information:

› Control panel. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 132
› Control panel configuration  . . . . . . . . . . . . . . . . . . . . 133
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Control panel

Description With the customizable control panel Project Parameters, 
customized parameters may be added. These will be avail-
able for saving and captioning images, together with the 
standard parameters.

see “Configuring Save buttons” on page 53

After configuration, input fields for the respective parame-
ters will be displayed in the control panel. Depending on 
the configuration, the parameter values for each image ac-
quisition might be entered manually or counted automati-
cally.

Structure The following figure shows the Project Parameters control 
panel with the following components:

Function The following table contains information on the 
components of the Project Parameters control panel:

2

3

4

1

No. Function

1 Configurable title of the control panel.

2 Input field of text type.

3 Input field of number type.

4 Selection list with configurable selection options.
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Continuation next page … 

Control panel configuration

Before getting started Complete the following steps before configuring the con-
trol panel:

1. In the info menu, open the Environment dialog win-
dow to locate the configuration file saving location.

2. Close the DISS 6 Software.

Process To use the control panel and customized parameters, the 
following process must be followed:

1. Add a control panel.
2. Create a parameter.
3. Activate the parameter.

CAUTION

Malfunction due to faulty configuration!

Configuration faults (e. g. write errors, accidental dele-
tion or modification of configuration file entries, …) may 
lead to malfunction of the DISS 6 Software.
– Configuration should only be performed by a service 

technician. (see “Service technicians” on page 7)

File View Info

Contents F1

About…

point electronic homepage

Environment…
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… Continuation: Control panel configuration

Continuation next page … 

Adding a control panel Complete the following steps to add the control panel:

1. At the saving location of the configuration files, open 
the file “SidePanels.xml” with a text editor (e. g. Note-
pad++).

2. Create a line with the following structure:

Mind the correct writing!

3. Save the file “SidePanels.xml” at the saving location of 
the configuration files (overwrite existing file).

No. Component Description

1 XML element panel Creates a control panel.

2 Attribute id Identifies the control panel.

The value of the attribute must 
be “usp”!

3 Attribute caption Name of the control panel.

Any value may be used.

1 2 3
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… Continuation: Control panel configuration

Continuation next page … 

Grouping control panels Control panels may be grouped. If a control panel of a 
group is opened in the user interface of the DISS 6 Soft-
ware, all control panels of this group will be displayed.

Complete the following steps to group control panels:

1. At the saving location of the configuration files, open 
the file “SidePanels.xml” with a text editor (e. g. Note-
pad++).

2. Create a block with the following structure:

Mind the correct writing!

3. Save the file “SidePanels.xml” at the saving location of 
the configuration files (overwrite existing file).

No. Component Description

1 XML element group Creates a control panel group.

2 Attribute caption Name of the control panel group.

Any value may be used.

3 Attribute dock Defines on which side of the user 
interface the control panel group is to 
be displayed.
Possible values: left and right

4 First control panel The order of the control panel sets 
the order within the user interface.

5 Second control 
panel

The order of the control panel sets 
the order within the user interface.

1 2 3

5 4
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… Continuation: Control panel configuration

Continuation next page … 

Adding parameters After the “Project Parameters” control panel has been 
added, the parameters may be created.

Complete the following steps to create parameters within 
the control panel:

1. At the saving location of the configuration files, open 
the file “UserParams.xml” with a text editor (e. g. 
Notepad++).

2. Create the following block:

Mind the correct writing!

1 2 3 4 5 6

7

No. Component Description

1 XML element usp Defines the Project Parameters control panel.

The name of the element must be “usp”!

2 XML element
parameter

Creates a parameter.

3 Attribute name Defines the name of the parameter.

Do not use spaces or special characters in the name!

4 Attribute label Defines the parameter label in the user interface.

Any value may be used.

5 Attribute type Defines the type of the parameter. The following types may be used:
– text: Defines a text field.
– int: Defines a number field within which the value may be raised or 

lowered manually with the arrow keys.

6 Attribute autoinc Activates an automatic counter in number fields.
Apart from the automatic count, the value of the number fields may 
also be edited manually by using the arrow keys.
Double-clicking an automatic number field resets the value.

This attribute may only be used for parameters of int type.

7 Attribute list Modifies a text field to a selection list with predefined options.
The options are entered into the attribute as values with single quo-
tation marks and space-delimited.

This attribute may only be used for parameters of text type.
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… Continuation: Control panel configuration

3. Save the file “UserParams.xml” at the saving location 
of the configuration files (overwrite existing file).

Activating the parameters To use created parameters, they have to be activated for 
the DISS 6 Software.

Complete the following steps to activate created parame-
ters:

1. At the saving location of the configuration files, open 
the file “DISS6.cfg” with a text editor (e. g. Note-
pad++).

2. In the file “DISS6.cfg” scroll to the [ParameterAliases] 
part.

3. Create a line for each parameter as follows:

Mind the correct writing!

4. Save the file “DISS6.cfg” at the saving location of the 
configuration files (overwrite existing file).

No. Component Description

1 Parameter Name The defined name of the parameter.

Use the same spelling as in User-
Params.xml!

see “Adding parameters” on 
page 136

2 Alias Value Name of the parameter in XMP format.

3 Alias Type Type of the parameter in XMP.

4 Alias Format Format of the parameter in XMP.

1 3 42
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7 Image processing

Chapter overview

Purpose This chapter gives information on the image processing 
software DIPS. It contains descriptions of structure and 
function of the software.

Contents This chapter contains the following sections:

› 7.1 User interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . 139
› 7.2 Functions in the File menu . . . . . . . . . . . . . . . . . . 156
› 7.3 Functions in the Image menu . . . . . . . . . . . . . . . . 166
› 7.4 Functions in the Tools menu. . . . . . . . . . . . . . . . . 181
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7.1 User interface

Overview

Purpose This section contains descriptions on the structure and 
function of the DIPS image processing software.

Contents This sections contains the following information:

› Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 140
› Toolbars. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 142
› File menu. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 146
› Edit menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 148
› Image menu. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 149
› Tools menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 151
› View menu. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 153
› Window menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 154
› Help menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 155
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Continuation next page … 

Overview

Description With DIPS, the digital imaging processing system of DISS 6, 
digitized images may be processed, labeled, measured, 
printed and saved easily.

A special layout technique facilitates the processing of sev-
eral related images as well as their documentation and ar-
chiving.

Structure The following figure shows the DIPS user interface with its 
components:

Function The following table contains information on the compo-
nents of the DIPS user interface:

1

3

4

2

No. Component Function

1 Menu bar Contains all DIPS functions.
The display of the menus may be customized.

see “Commands tab” on page 144
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… Continuation: Overview

2 Toolbars Contain functions of DIPS as command buttons.
The content of the toolbars may be customized either via the prefer-
ences or according to user-specific requirements.

see “Toolbars tab” on page 143

3 Work area Contains all opened image windows as well as dialog windows of the 
active tools or functions.

4 Status bar – Displays possible functions or actions of the active tool.
– Displays measurement results of the active tool (e. g. size of an 

angle).

No. Component Function
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Continuation next page … 

Toolbars

Introduction Toolbars contain some frequently used menu functions. 
The functions are represented in three groups. DIPS pro-
vides the following options to organize the functions ac-
cording to specific requirements:

– Display or hide toolbars
– Expand existing toolbars
– Delete functions from existing toolbars
– Create user-specific toolbars
– Set-up of display options for menus

Context menu Show, hide or customize all available toolbars via the con-
text menu. The context menu may be opened by a right-
click on the toolbars or menu bars.

The following figure shows the context menu of the tool-
bars and menu bars:

Customizing toolbars Open the Customize dialog window with three tabs via the 
context menu to customize the toolbars.
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… Continuation: Toolbars

Continuation next page … 

Toolbars tab The following figure shows the Customize dialog window 
with the Toolbars tab:

The following table contains information on the compo-
nents of the Toolbars tab:

Component Function

Toolbars Shows all available toolbars.
Each toolbar may be shown or hidden by using the checkbox.

New… Opens a dialog window for creating a new toolbar.

Rename… Opens a dialog window for renaming the selected toolbar.

The standard toolbars (Main Menu, File, Tools and Image) cannot 
be renamed.

Delete... Deletes the selected toolbar.

The standard toolbars (Main Menu, File, Tools and Image) cannot 
be deleted.

Reset… Resets a modified standard toolbar to default.

Only the standard toolbars (Main Menu, File, Tools and Image) 
may be reset.



Image processing User interface

point electronic GmbH DISS 6 Software 144 / 206

Version: 6.4.0.0 Reference guide 26.02.2025

… Continuation: Toolbars

Continuation next page … 

Commands tab As soon as the Commands tab is opened, the edit mode for 
all menus and toolbars is activated. In this mode, menus 
and tools may be deleted or moved via Drag & Drop.

The following figure shows the Customize dialog window 
with the Commands tab:

The following table contains information on the compo-
nents of the Commands tab:

Component Function

Categories Displays all available menus.

Commands Displays the content of the menu which is selected in the Categories 
field.
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… Continuation: Toolbars

Options tab The following figure shows the Customize dialog window 
with the Options tab:

The following table contains information on the compo-
nents of the Options tab:

Component Function

Personalized menus and 
toolbars

– Menus show recently used 
commands first

Displays only the most commonly used commands in the menus.

– Show full menus after a 
short delay

Shows all commands in the menus after a short delay.

– Reset my usage data Deletes the personal usage data.
All menus will be displayed with all commands.

Other

– Large icons Shows large icons in the toolbars.

– Show ToolTips on toolbars Shows a tool tip if the cursor is on an icon in the toolbar.

– Show shortcut keys in 
ToolTips

Shows shortcut keys in the tool tips.

– Menu animations Contains a list of animation effects for showing menus.
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File menu

Structure The following figure shows the File menu with its compo-
nents:

Function The following table contains information on the compo-
nents of the File menu:

Component Function

New Layout Opens a dialog window for creating layout templates.
(Page 157)
A layout template consists of several empty fields in which different 
images may be arranged.

Open… Opens the Load image dialog window to select image files or layout 
files and open them in DIPS.

DIPS supports the following file formats:

– Tagged Image File Format (.TIF)
– Windows Bitmap (.BMP)
– Joint Picture Expert Group (.JPG)
– Portable Network Graphics (.PNG)
– Graphics Interchange Format (.GIF)
– DOS-DISS (.PSD)

Image browser Opens the visual image management where saved images are dis-
played in a preview.
(Page 158)
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… Continuation: File menu

Save Saves the active image window or layout window.
If the active image or layout has not previously been saved, the Save 
image dialog window opens.

Save as… Opens the Save image dialog window. Images and layouts may be 
saved with another name in specific folders.
(Page 159)

Images and layouts may be saved in one of the following file for-
mats:
– Tagged Image File Format (.TIF)
– Windows Bitmap (.BMP)
– Joint Picture Expert Group (.JPG)
– Portable Network Graphics (.PNG)
– Graphics Interchange Format (.GIF)
– DOS-DISS (.PSD)

 Auto save Opens a menu for activating or setting further options.
(Page 161)

Export Exports point scan or linescan data acquired from the DISS 6 TWAIN 
source to ASCII or Excel format.

Printer setup… Opens a dialog window for selecting and/or setting up the con-
nected printers.

Print... Opens the Print dialog window with functions to prepare and carry 
out the printing of the active image or layout.
(Page 162)

Select TWAIN source Shows all available TWAIN sources. One source may be selected as 
standard.

Acquire from TWAIN… Opens the standard TWAIN source for acquiring images or layouts.

Acquire from Falcon Grab-
ber…

Opens the TWAIN source for acquiring analog video signals (e. g. 
from an optical microscope) with a frame grabber card.

Program preferences Opens the Program preferences dialog window for setting user-spe-
cific defaults.
(Page 163)

Ending Closes the application.

Component Function
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Edit menu

Structure The following figure shows the Edit menu with its compo-
nents:

Function The following table contains information on the compo-
nents of the Edit menu:

Component Function

Undo Undoes the last action.

Copy Copies the selected image to the clipboard 
of the computer.

Paste Pastes an image from the clipboard into a 
new image window.

Paste image data Pastes an image acquired with another 
image processing software from the clip-
board of the computer.
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Continuation next page … 

Image menu

Structure The following figure shows the Image menu with its com-
ponents:

Function The following table contains information on the compo-
nents of the Image menu:

Component Function

Brightness/Contrast… Opens a dialog window for setting up brightness and contrast.
(Page 167)

Histogram functions… Opens a dialog window for setting up functions for modifying the 
histogram.
(Page 168)

Rotate... Opens a dialog window for rotating the selected image.
(Page 170)

Matrix filter… Opens a dialog window for setting up different filters.
(Page 171)

Equidensities… Opens a dialog window for setting and dyeing several gray areas of 
an image.
(Page 173)

Phase analysis...
(optional)

Starts an application to identify different chemical phases in elemen-
tal mapping images.

Invert Shows the selected image in the inverted mode.

Convert to gray scale Converts the active image to gray scales.
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… Continuation: Image menu

Calibrate… Opens a dialog window for calibrating DIPS.
(Page 177)

This function is only available in measuring mode.

Calibrate scanned image… Opens a dialog window for calibrating images acquired with another 
source (e. g. frame grabber or scanner).
(Page 179)

Image info window Opens a dialog window that shows information saved with the active 
image.
(Page 180)

Component Function
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Tools menu

Structure The following figure shows the Tools menu with its compo-
nents:

Function The following table contains information on the compo-
nents of the Tools menu:

Component Function

Standard Switches to standard mode.
Zoom mode and measuring mode will be deactivated.

Drag & Drop is only available in standard mode.

Zoom Activates zoom mode.
(Page 182)

Crop Crops rectangular sections from the selected image.
(Page 183)

Measurement cursor Activates measuring mode.
(Page 184)

Angle measurement Activates angle measuring mode.
(Page 186)

Line Profile Activates line profile measuring mode.
(Page 187)

Structure measurement Activates structure measuring mode.
(Page 188)
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… Continuation: Tools menu

Image caption Opens a dialog window for creating an image caption.
(Page 190)

Label For entering label text on any position in the image.
(Page 193)

Arrow Callout tools: Creates an arrow on any position in the selected 
image.
(Page 195)

Rectangle Callout tools: Creates a rectangle on any position in the selected 
image.
(Page 195)

Ellipse Callout tools: Creates an ellipse on any position in the selected 
image.
(Page 195)

Measurement values win-
dow

Opens the Measurement values dialog window in which the mea-
sured distances, radii and angles of the selected image are displayed 
as tables. The data may be saved either as XLS, HTML or TXT format.
(Page 199)

Mix window Opens a dialog window for dyeing and/or mixing images.
(Page 200)

Color palette window Opens the Color palette window.
Via Drag & Drop, a color palette may be assigned to an image in an 
image window or a layout window.

Component Function
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View menu

Structure The following figure shows the View menu with its compo-
nents:

Function The following table contains information on the compo-
nents of the View menu:

Component Function

100% Displays the current image or layout in stan-
dard view.
One screen pixel corresponds to one image 
pixel.

Fit in window Fits the current image or layout into the 
image window.
The aspect ratio will be maintained.

Full screen Displays the current image or layout in full 
screen mode.
The re-execution of this function switches 
back to standard view.
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Window menu

Structure The following figure shows the Window menu with its com-
ponents:

Function The following table contains information on the compo-
nents of the Window menu:

Component Function

Cascade Cascades all opened image windows one 
after the other graded at an angle on the 
DIPS user interface.

Arrange symbols Arranges all symbols (minimized image win-
dows) on the lower edge of the DIPS user 
interface.

Tile horizontally Arranges all opened image windows one 
beneath another on the DIPS user interface.

Tile vertically Arranges all opened image windows side by 
side on the DIPS user interface.

Minimize all Minimizes all opened image windows to 
symbols (minimized image windows).
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Help menu

Structure The following figure shows the Help menu with its compo-
nents:

Function The following table contains information on the compo-
nents of the Help menu:

Component Function

Contents Opens the help file.

Registration... Opens the Registration dialog window for 
entering registration data.
This information may be sent to point elec-
tronic GmbH by email or may be saved as 
TXT file.

About… Opens a window with copyright information, 
software version and serial number.
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7.2 Functions in the File menu

Overview

Purpose This section contains detailed descriptions of specific func-
tions in the File menu.

Contents This sections contains the following information:

› New layout  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 157
› Image browser. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 158
› Save as… . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 159
› Auto save. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 161
› Print… . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 162
› Program preferences. . . . . . . . . . . . . . . . . . . . . . . . . . 163
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New layout

Description With a layout, several acquired images can be arranged in 
one window.

This is useful e. g. for a comparison of images with differ-
ent settings or a creation of print layouts.

This function opens the New Layout dialog window in 
which new layout templates for the arrangement of several 
images can be created.

Structure The following figure shows the New Layout dialog window 
with the following components:

Function The following table contains information on the compo-
nents of the New Layout dialog window:

Component Function

Columns For entering a preferred number of columns 
for a layout template.

Rows For entering a preferred number of rows for 
a layout template.

Ratio For entering a preferred aspect ratio of a lay-
out template.

OK Closes the dialog window.
A new layout template is created with the 
given values and is displayed on the work 
area of DIPS.

Cancel Closes the dialog window.
The settings are rejected. No new layout 
template is created.
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Image browser

Description The image browser is a visual image manager integrated in 
DIPS. It allows a preview of saved images as thumbnails.

With a double-click on a thumbnail, the image is opened in 
DIPS.

Structure The following figure shows the image browser with its main 
components:

Function The following table contains information on the main com-
ponents of the image browser:

1

2

3

No. Main component Function

1 Directory Displays disk drives and folders of the computer.

2 File properties Displays information saved with a selected image.

3 Preview Displays thumbnails and file names of the images in a selected folder.
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Save as…

Description With the Save as... function, selected images or layouts can 
be saved under a different name in the following file for-
mats:

– Tagged Image File Format (.TIF)
– Windows Bitmap (.BMP)
– Joint Picture Expert Group (.JPG)
– Portable Network Graphics (.PNG)
– Graphics Interchange Format (.GIF)

The function opens the Save image dialog window.

Structure The following figure shows Save image dialog window with 
its main components:

NOTICE

Only in a TIF file, image parameters like calibration and 
comment may be saved with the image.
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… Continuation: Save as…

Function The following table contains information on the main com-
ponents of the Save image dialog window.

Main component Function

Options

– 16 bit format (raw data) Saves the raw data of the selected image in 16-bit format.
This option is only available if the image data to be saved is available 
in 16-bit format.

If the 16-bit format (raw data) checkbox is activated, all modifica-
tions of the image will be rejected.

– Layout as single image Saves a layout as single image.
Such a layout may also be imported into different graphics applica-
tions.

With layouts saved as single images, it becomes impossible to 
process the individual images of a layout afterwards.

– Use image zoom Causes the layout to be saved as shown on the screen.

The zooming degree of the individual images of a layout is pre-
served.

Single image Sets width and height of the image to be saved in pixels.

JPEG Sets the quality of the image to be saved by entering a value 
between 1 and 100.

The higher the value, the better the quality of the saved image.



Image processing Functions in the File menu

point electronic GmbH DISS 6 Software 161 / 206

Version: 6.4.0.0 Reference guide 26.02.2025

Auto save

Description The Auto save function enables the quick saving of several 
images with the same name. While saving several images, 
the chosen file name is extended with a four-digit number 
starting at 0001. The number is raised by one for any fur-
ther saving.

Structure The following figure shows the Auto save menu with its 
components:

Function The following table contains information on the compo-
nents of the Auto save menu:

Component Function

Active Activates the auto save mode.

File name… Opens a dialog window for choosing a file 
name and to set some saving options.
This dialog window is basically the same as 
the Save image dialog window (Page 159).
In the Options field, a Close image automati-
cally function is available. If this function is 
activated, the image is closed directly after 
the saving.

The Layout as single image function can-
not be activated.
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Print…

Description With the Print function, the active image or layout can be 
prepared for printing and can be printed out.

The function opens the Print dialog window.

Structure The following figure shows the Print dialog window with 
the following components:

Function The following table contains information on the compo-
nents of the Print dialog window:

Component Function

Options

– Use image zoom Prints the active image or layout as shown on the screen.

– Center on page Prints the active image or layout centered on the page.

Orientation Contains the options Portrait and Landscape to set the page orienta-
tion.

Margins (mm) For setting the page margins in millimeter.

As a default, images and layouts are aligned on the upper left 
edge.

Copies For entering the number of image or layout copies to be printed.

OK Closes the dialog window.
The image is printed with the preset settings.

Cancel Closes the dialog window.
The image is not printed. The preset settings are rejected.

Setup… Opens a dialog window for selecting and setting up the printer.
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Program preferences

Description With the Program preferences function, user-specific de-
faults for DIPS can be set.

The function opens the Program Preferences dialog win-
dow with three tabs.

TWAIN tab The following figure shows the Program Preferences 
dialog window with the TWAIN tab:

The following table contains information on the compo-
nents of the TWAIN tab:

Component Function

Show current TWAIN source 
as hint

Displays the current TWAIN source as tool tip if the cursor is placed 
on the Acquire From TWAIN button.

Close TWAIN source after 
acquisition

Closes the TWAIN source after acquisition and transfer of an image 
to DIPS.
Otherwise, the TWAIN source stays open until the image acquisition 
is canceled.
This mode allows to acquire several images one after another and to 
transfer them to the image processing software without having to 
open the TWAIN source again.

 Override in auto save mode The TWAIN source is not closed in auto save mode.

Acquire directly from DISS 5 
(without TWAIN)

Activates direct data transfer from the image acquisition software.
If image acquisition software is available, it will open automatically 
when the Acquire from TWAIN… function is used without using the 
TWAIN source.

Only available as package with DISS 5.
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Continuation next page … 

View tab The View tab contains a function that displays the toolbar 
buttons in a flat style.

Miscellaneous tab The following figure shows the Program Preferences 
dialog window with the Miscellaneous tab:

The following table contains information on the compo-
nents of the Miscellaneous tab:

Component Function

Next image number For entering a number to be used for the next image saved.

Confirmation for saving 
images

If this checkbox is activated, the saving of an existing image must 
always be confirmed. This prevents an original image from being 
overwritten.

This function should always be activated.

 Max. size for auto scale When an image is acquired from the TWAIN source and as long as its 
width and/or height do not exceed the given values, the image will 
automatically be converted to twice its size.
As this function improves the pixel resolution of an image, it is partic-
ularly well suited for layouts with small elemental mapping images 
that are provided with an image caption.

The automatic scaling may be prevented by entering the value 
“0” in this field.

Smooth Scaling Activates an interpolating procedure used for automatic scaling.
Otherwise, the image is scaled with a simple pixel duplication.
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Scaling The following images show the effect of scaling. For this 
purpose, an SE image was acquired with 80 × 64 pixels and 
labeled with a caption.

Scaling Image

Without

Regular

Smooth
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7.3 Functions in the Image menu

Overview

Purpose This section contains detailed descriptions of specific func-
tions in the Image menu.

Contents This sections contains the following information:

› Brightness/Contrast… . . . . . . . . . . . . . . . . . . . . . . . . . 167
› Histogram functions…. . . . . . . . . . . . . . . . . . . . . . . . . 168
› Rotate…  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 170
› Matrix filter…  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 171
› Equidensities… . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 173
› Calibrate…  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 177
› Calibrate scanned image… . . . . . . . . . . . . . . . . . . . . . 179
› Image info window . . . . . . . . . . . . . . . . . . . . . . . . . . . 180
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Brightness/Contrast…

Structure The following figure shows the Brightness/Contrast dialog 
window with its main components:

Function The following table contains information on the main com-
ponents of the Brightness/Contrast dialog window.

1

2

3

No. Main component Function

1 "Brightness" slider Modifies the brightness of the selected image within a range of -
100% to +100%. 

2 "Contrast" slider Modifies the contrast of the selected image within a range of -100% 
to +100%. 

3 Color mode buttons Selects a color mode (gray scales, red, green or blue) to which the 
values of brightness and/or contrast may be adapted.

OK Closes the dialog window.
All settings are applied.

Cancel Closes the dialog window.
All settings are rejected.

Reset Resets the sliders to the value “0” (zero).
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Histogram functions…

Description A histogram shows the frequency distribution of the gray 
values in an image.

This function opens the Histogram Functions dialog win-
dow with three tabs containing several functions to change 
the histogram of a selected image.

Equalization tab The following figure shows the Histogram Functions dialog 
window with the Equalization tab:

A histogram equalization often leads to an improvement of 
the image. During equalization, narrow gray scale ranges 
due to suboptimal image acquisition conditions are wid-
ened.

With the slider, the intensity of the histogram equalization 
may be adjusted within a range from 0% to 100%. After re-
calculation, these modifications will instantly be visible in 
the histogram as well as the image. As these recalculations 
might take some time with larger images, the status will be 
displayed in the title bar of the dialog window.
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Range tab The following figure shows the Histogram Functions dialog 
window with the Range tab:

Using the mouse, the two red bars from the right and/or 
left edge may be dragged over the histogram to define a 
certain range of gray values in the active picture. Only 
those pixels of the current image will be shown whose gray 
value lays within the two markers.

Area tab The following figure shows the Histogram Functions dialog 
window with the Area tab:

Using the mouse, the two red bars from the right and/or 
left edge may be dragged over the histogram to determine 
percentages of areas with a certain range of gray values. In 
the current image window, these areas are shown in red, 
and the gray value range and percentage will be displayed.
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Rotate…

Structure The following figure shows the Image Rotation dialog 
window with the following components:

Function The following table contains information on the compo-
nents of the Image Rotation dialog window:

Component Function

Angle For entering an angle around which the image is rotated.

– Arrow buttons Raise or lower the value of the angle in single steps.

– Double arrow buttons Raise or lower the value of the angle in single steps.

OK Closes the dialog window.
The image is rotated with the entered value.

Cancel Closes the dialog window.
The entered angle value is rejected. The image is not rotated.
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Matrix filter…

Description Matrix filters modify a pixel's intensity depending on the in-
tensity of original and surrounding pixels. An appropriate 
filter matrix leads to certain filter functions, such as smooth-
ing or sharpening of images or emphasizing edges.

With the Matrix Filter dialog window, existing filters may 
be selected or modified, and new filters may be defined.

Structure The following figure shows the Matrix Filter dialog window 
with the following components:

Function The following table contains information on the compo-
nents of the Matrix Filter dialog window:

Component Function

Filter Displays a list of all available filters.

– Plus Adds a new filter for user-specific settings.

– Minus Deletes the selected filter from the list.

– Arrow For renaming the selected filter.

Matrix Displays the coefficients of the selected filter. The coefficients may 
be modified within a range from -128 to +127.

– Divisor – Standardizes the calculated intensities after the application of a 
matrix filter.

– Corresponds to the sum of the matrix coefficients.

– Bias Shifts the calculated intensities by the entered value.
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… Continuation: Matrix filter…

Apply Closes the dialog window.
The selected filter is applied to the image. Modifications of the filter 
are saved.

Preview Shows a preview of the filter on the selected image. The filter is not 
applied to the image.

OK Closes the dialog window.
Modified and/or newly created filters are saved but not applied to 
the image.

Cancel Closes the dialog window.
Modified and/or newly created filters are not saved. Modifications 
are not applied to the image.

Component Function
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Equidensities…

Description Equidensities are lines or areas which connect pixels with 
equal optical or color densities. In the Equidensities dialog 
window, threshold values for the optical density may be de-
fined. In the selected image, these densities will be dis-
played as equidensities in two different ways.

Equidensities may be helpful to highlight image areas that 
show very little difference in B/W images or to quickly de-
termine percentages of areas with equal optical density, 
e. g. phases.

The Equidensities function basically is an extension of the 
Area tab from the Histogram Functions dialog window. 
There, one gray value range may be selected and its per-
centage calculated. With the Equidensities function, sev-
eral gray value ranges may be defined and allocated to 
different colors. The percentages of individual areas will 
also be determined.

Original image and Equidensities window
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Continuation next page … 

Equidensities as area display

Equidensities as dotted graphics
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Structure The following figure shows the Equidensities dialog 
window with the following components:

Function The following table contains information on the compo-
nents of the Equidensities dialog window:

2

1

3

4

No. Component Function

1 Histogram Displays the distribution of gray scales in the selected image:
– left: 0 = black
– right: 255 = white
A right-click on the histogram opens a context menu with two func-
tions:
– Add: Adds a new threshold to the histogram. A vertical bar is dis-

played. It may be shifted with the mouse to set the threshold.
– Delete: Deletes the threshold selected in the image and shows all 

activated thermosets as vertical bars. All bars may be moved with 
the mouse to readjust the thresholds.

2 Area Displays an area of a threshold in the color selected for the thresh-
old.
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3 Threshold list Displays all defined thresholds in a list:
– Checkbox: Activates or deactivates the threshold.
– Threshold (%): Displays the percentage position of the threshold 

in the total gray scale area (between 0% and 100%).
– Threshold (abs.): Displays the absolute position of the threshold in 

the total gray scale area (between 0 and 255).
– Area (%): Displays the area within a threshold as a percentage of 

the total area (between 0% and 100%).
A right-click on the threshold list opens a context menu with two 
functions:
– Add: Opens the New Threshold dialog window with two input 

fields to define the percentage or the absolute position of a new 
threshold.

– Delete: Deletes the selected threshold.

4 Threshold color Assigns a color to the selected threshold.

Area display Dyes the area of the threshold with the selected color in the active 
image.

OK Closes the dialog window.
The selected image is dyed with all defined and activated thresholds.

Dyed images cannot be reconverted to gray scale images.

Cancel Closes the dialog window.
All thresholds defined for the selected image are rejected.

Export… Opens the Export Table dialog window to export the threshold list 
as an XLS file.

No. Component Function
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Calibrate…

Description The Calibrate function is only available in measuring mode.

With this function, DIPS may be calibrated. For the calibra-
tion, an image with structures (test grid) is acquired with a 
high resolution and known dimensions. After entering the 
magnification, the image is transferred to the DIPS user in-
terface.

In measuring mode, the corresponding vertical or horizon-
tal measurement cursors are placed on these structures.

The function opens the Calibrate dialog window.

Structure The following figure shows the Calibrate dialog window 
with the following components:

Function The following table contains information on the compo-
nents of the Calibrate dialog window:

Component Function

Measurement direction Contains checkboxes X, Y for the selection of the measurement 
direction to be calibrated and checkbox D for the selection of the 
distance.

Correction Contains three input fields to calibrate the selected measurement 
direction.

– Measured distance [pixel] For entering the measured distance in pixels.

– Real distance [µm] For entering the real distance in micrometer.

– Magnification For entering the magnification.

OK Closes the dialog window.
All settings are applied to the active image, but are not saved for fur-
ther image acquisitions.

Save Closes the dialog window.
All settings are saved.

This button should only be clicked after the calibration of DIPS.
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… Continuation: Calibrate…

In the dialog window, the real distance is entered in X or Y 
direction. By clicking the Save button, the system is cali-
brated and the dialog window is closed.

The determined correlations between pixel and microme-
ter are saved under Registry/DISS5.ini.

If images contain a structure with known dimensions, non-
calibrated images may also be calibrated later. For this, the 
measurement cursor must be positioned at the known 
structure, and the known value for X or Y distance must be 
entered. Then click the OK button.

Cancel Closes the dialog window.
All settings are rejected.

Component Function

NOTICE

If the system was calibrated after installation, the Save 
button must not be clicked when recalibrating an image. 
Clicking this button would override the calibration.



Image processing Functions in the Image menu

point electronic GmbH DISS 6 Software 179 / 206

Version: 6.4.0.0 Reference guide 26.02.2025

Calibrate scanned image…

Description The Calibrate scanned image... function is used to calibrate 
images not acquired from the DISS 6 Software TWAIN 
source but from another source (e. g. frame grabber or 
scanner). An image is calibrated with known structures and 
with the specification of the used magnification.

This function opens the Calibrate Scanned Image dialog 
window.

Structure The following figure shows the Calibrate Scanned Image 
dialog window with the following components:

Function The following table contains information on the compo-
nents of the Calibrate Scanned Image dialog window:

Component Function

Magnification For entering the current magnification.

Resolution (dpi) For entering the resolution in dpi.

OK Closes the dialog window.
The connected acquisition source is calibrated with the settings.

Cancel Closes the dialog window.
The settings are rejected. The connected acquisition source is not 
calibrated.
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Image info window

Description The Image info window displays information saved with the 
current image. In the window, the information is grouped 
as hardware, image and scan parameters.

Additional information like an image comment or source 
name may also be entered.

This function opens the Image info dialog window with two 
tabs.

Structure The following figure shows the Image info dialog window:

NOTICE

Additional image information is saved only if the image 
is saved in TIF format.
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7.4 Functions in the Tools menu

Overview

Purpose This section contains detailed descriptions of specific func-
tions in the Tools menu.

Contents This sections contains the following information:

› Zoom . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 182
› Crop. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 183
› Measurement cursor . . . . . . . . . . . . . . . . . . . . . . . . . . 184
› Angle measurement  . . . . . . . . . . . . . . . . . . . . . . . . . . 186
› Line Profile. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 187
› Structure measurement (optional)  . . . . . . . . . . . . . . . 188
› Image caption . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 190
› Label  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 193
› Callout tools  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 195
› Point scan data  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 197
› Measurement values window . . . . . . . . . . . . . . . . . . . 199
› Mix window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 200
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Zoom

Description The Zoom function activates zoom mode.

In this mode, the mouse cursor is displayed as a magnifier 
over the active image.

A click on the left mouse button magnifies the image, a 
click on the right mouse button reduces the image magni-
fication. The clicked point is moved to the center of the im-
age.

The current magnifying factor is displayed in the title bar of 
the image window.

Pressing the [Ctrl] key in zoom mode changes the mouse 
cursor from magnifier to a hand symbol. This is used to 
move the section for the image view.

The Zoom function is also available in full screen mode.



Image processing Functions in the Tools menu

point electronic GmbH DISS 6 Software 183 / 206

Version: 6.4.0.0 Reference guide 26.02.2025

Crop

Description The Crop function allows to crop a rectangular section from 
the image. The cropped sections may be combined to cre-
ate a new image.

Position the mouse pointer in the active window, keep the 
left mouse button pressed and draw the preferred rectan-
gle. Width and height of the rectangular section are dis-
played in the status bar.

By pressing the return key, a new image with the data of 
the selected section will be created.

The following figure shows the Crop function:
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Measurement cursor

Description The Measurement cursor function activates the measure-
ment function.

The measurement function allows to determine distances 
in X, Y and diagonal direction with the help of the double 
cross measurement cursor.

Measurement data for all directions are displayed in the 
status bar.

For all non-calibrated images, the unit for measuring dis-
tances is pixel.

If they contain known structures or a measuring bar, these 
images might be calibrated later via the Image > Calibrate 
menu.

All images acquired and transferred into DIPS are automat-
ically calibrated provided the SEM magnification has been 
entered or automatically read-out after image acquisition.

The double cross measurement cursor may be positioned 
with the mouse. Lines or corners of the measurement cur-
sor may be moved with pressed left mouse button. By 
pressing the left mouse button while pressing the [Ctrl] key, 
the closest corner will be caught. Pressing the space bar 
catches the whole measurement cursor in the active image 
section.

In high resolution images, the measurement cursor may 
easily be positioned when zooming the image. With the [+] 
and [-] keys of the numeric keypad, the zoom may be 
changed in the measuring mode.

While directly switching from measuring to zoom mode, 
the deactivated measurement cursor will remain visible. 
Thus, the relevant image section may be zoomed before 
switching back to measuring mode for positioning the 
measurement cursor.

The highlighted measuring length of the measurement 
cursor including the dimensioning may be added to the 
image. Pressing the return key opens the Label dialog 
window (Page 193) for entering the standard caption.

When pressing the tab key, another measuring length of 
the measurement cursor will be selected for a label.

With the mouse, the dimension caption may be moved to 
any position in the image.
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To modify the font size, use [Ctrl] + [+] or [-] on the numeric 
keypad.

A confirmed label is fixedly integrated into the image and 
saved as image information. Before confirming captions, 
the original image should be backed-up. Via Edit > Undo or 
by clicking the mouse on the Undo button in the toolbar, 
the last label may be rejected.
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Angle measurement

Description Use the mouse to select the two end points of the angle 
arms. Then determine the vertex.

By clicking the mouse on the preferred location, the posi-
tion of the displayed angle may be modified. The nearest 
point will be caught.

Use the mouse to move the angle caption to another posi-
tion. To modify the font size, use [Ctrl] + [+] or [-] on the nu-
meric keypad.

By pressing the return key, the shown angle is integrated 
into the image. The Label dialog window (Page 193) opens 
where you may confirm or change the angle caption.

During angle measurement, the status bar shows the fol-
lowing information:

– 1: Description of the keys for angle measurement set-
tings including function

– 2: Size of the currently measured angle

The following figure shows the angle measurement:

1 2
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Line Profile

Description The line profile displays the structure of a surface along a 
horizontal measurement line over the entire image.

Structure The following figure shows the Line Profile dialog window 
with the following components:

Function The following table contains information on the compo-
nents of the Line Profile dialog window:

Component Function

Scaling

– Automatic Scales the diagram depending on the minimal 
and maximal values.

– Zero based Scales the diagram starting from the zero base.

– Min, max For manual scaling of the diagram with disabled 
automatic.

Line count Expands the measuring area in vertical direction 
by the measurement line. The measuring area is 
displayed with green lines.

Position Displays the vertical position of a measuring line 
in the active image.

Export… Exports the measurement data as CSV format.
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Structure measurement (optional)

Description The structure measurement allows measurements in a sub-
pixel range. Measurements may be averaged over one or 
several lines.

After the activation of structure measurement, a measuring 
line may be put into the image. To do this, starting point 
and final point have to be marked with the mouse.

The structure below this measuring line as well as the 
thresholds of the measurement are found automatically 
and are displayed in the Structure Measurement dialog 
window.

The length of the measuring line may be modified by mov-
ing the left and right edge with the mouse. The position of 
the measuring line may be changed by moving the line with 
the mouse. The position of the label may be changed in the 
same kind.

Structure The following figure shows the Structure Measurement 
dialog window with the following components:
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Function The following table contains information on the compo-
nents of the Structure Measurement dialog window:

Saving of measuring data in
the image

After the determination of the measuring data, a labeled 
measuring line may be integrated into the active image.

Pressing the return key opens the Label dialog window. 
(Page 193)

Component Function

Diagram Displays the measurement area in graphical and numerical style.

Red value and red bar Display the minimal value.

Black value and black bar Display the threshold value.

Blue value and blue bar Display the maximal value.

Drain Measures the structure as a drain.

Level Sets the threshold value in single steps or steps of ten.

Line count Sets the number of measuring lines in the measuring area. This 
expands the measuring area in vertical direction.

Original data Additionally displays the unsmoothed original data.

Spline smoothing Changes the value of the smoothing.

Auto Sets the value of the smoothing automatically.

Vertical Measures distances in vertical direction.

Indirect measurement Measures distances which do not lie on a line.
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Image caption

Description The Image caption function allows to create and save an im-
age comment for the active image. The first line of the en-
tered comment is displayed as image caption. Any 
additional text in the following lines is saved with the image 
if the image is saved as TIF file.

The function opens the Image Caption dialog window with 
the Image comment and Settings tabs.

Image comment tab The following figure shows the Image Caption dialog 
window with the Image comment tab:

The following table contains information on the compo-
nents of the Image comment tab:

NOTICE

Integrated text overwrites the pixels of the image at the 
position where it is applied.

1

2

No. Component Function

1 Text field For entering, editing and displaying the whole text saved with the 
active image.

Only the first text line is displayed in the image. Any additional 
text in the following lines is saved with the image if the image is 
saved as TIF file.

2 Preview Displays a preview of the comment text in the active image.
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Settings tab The following figure shows the Image Caption dialog 
window with the Settings tab:

The following table contains information on the compo-
nents of the Settings tab:

1

2

3

No. Component Function

1 Text line Displays the selected parameter in the given order and the freely 
definable image comment.

2 Parameter list Contains all parameters which are available for the image caption.

Add Parameters Adds the selected parameter to the text line.

Parameter format Opens a dialog window for editing the display format of the selected 
parameter.

Color Contains two lines with different color fields to select the foreground 
color and the background color of the text field.
A left-click in a color field selects the foreground color. The letters 
FG are added to the selected color.
A right-click in a color field selects the background color. The letters 
BG are added to the selected color.

– Transparent 
background

Displays the text field without background.

Automatic Adapts the font size to the resolution of the active image.

Line width For setting the width of the measuring bar in pixels.

Font Contains information on the used font and functions to modify and/
or reset the font.

– Change… Opens a dialog window for setting up some font properties.

– Reset Resets the font properties to the default.

3 Preview Displays a preview of the comment text in the active image.
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OK Closes the dialog window.
The image caption is displayed with the preset settings in the 
selected image.

In a layout with several images, the image caption is only dis-
played in the selected single image.

OK for all Closes the dialog window.
The image caption is displayed with the preset settings in all images 
of a selected layout.
This process may only be canceled for the last image of a layout.

This function is only available if a layout window with several 
images is selected on the DIPS interface.

Cancel Closes the dialog window.
The settings are rejected.

No. Component Function
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Label

Description The Label function allows to add text to any position in the 
active image. A left-click into the active image sets the po-
sition of the text.

The function opens the Caption dialog window.

Structure The following figure shows the Caption dialog window with 
the following components:

Function The following table contains information on the compo-
nents of the Caption dialog window:

NOTICE

Integrated text overwrites the pixels of the image at the 
position where it is applied.

Component Function

Text line For entering a label text.

Color Contains two lines with different color fields to select the foreground 
color and the background color of the text field.
A left-click in a color field selects the foreground color. The letters 
FG are added to the selected color.
A right-click in a color field selects the background color. The letters 
BG are added to the selected color.

Transparent
background

Displays the text field without background.

Automatic Adapts the font size to the resolution of the active image.

Line width For setting the width of the measuring bar in pixels.
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Font Contains information on the used font and functions to modify and/
or reset the font.

– Change… Opens a dialog window for setting up font properties.

– Reset Resets the font properties to the default.

OK Closes the dialog window.
The comment is displayed with the preset settings in the active 
image. Use the mouse to move the text to another position.
The label function only ends when another mode is activated.

Cancel Closes the dialog window.
The settings are rejected.

Component Function
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Callout tools

Description DIPS contains three callout tools to add graphic elements 
permanently to the active image.

The following table contains information on the available 
callout tools:

Icon Tool Function

Arrow
[Ctrl] + [A]

Adds an arrow to any position in the active image.
A click into the image with the left mouse button sets the target 
point of the arrow. With pressed mouse button, length and angle of 
the arrow may be set.
Length, position and angle of an inserted arrow may be modified by 
clicking the red intersections with the mouse.
Pressing the return key opens the 
Pen Settings dialog window for setting line width and color of the 
arrow.

Rectangle
[Ctrl] + [R]

Adds a rectangle to any position in the active image.
A click into the image with the left mouse button sets the upper left 
corner of the rectangle. With pressed mouse button, width and 
height of the rectangle may be set.
Width and height of the rectangle may be changed by clicking the 
red intersections with the mouse.
By clicking the mouse button within the rectangle and pulling it while 
pressing the mouse button, the position of the rectangle may be 
changed.
Pressing the return key opens the 
Pen Settings dialog window for setting line width and color of the 
rectangle.

Ellipse
[Ctrl] + [E]

Adds an ellipse to any position in the active image.
A click into the image with the left mouse button sets the upper left 
corner of the ellipse. With pressed mouse button, width and height 
of the ellipse may be set.
Width and height of the ellipse may be changed by clicking the red 
intersections with the mouse.
By clicking the mouse button within the ellipse and pulling it while 
pressing the mouse button, the position of the ellipse may be 
changed.
Pressing the return key opens the 
Pen Settings dialog window for setting line width and color of the 
ellipse.
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Dialog window
Pen Settings

The following figure shows the Pen Settings dialog window 
with the following components:

The following table contains information on the compo-
nents of the Pen Settings dialog window:

Component Function

Color Sets the line color of the drawn element.

Line width Sets the line width of the drawn element.

Automatic Automatically adapts the line width to the resolution of the active 
image.

OK Closes the dialog window.
The settings are applied to the drawn element.

After pressing the OK button, the drawn element is fixed into the 
image. Afterwards, the drawn element can neither be shifted nor 
can its settings be modified.

Cancel Closes the dialog window.
The settings are rejected.
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Point scan data

Description The Point scan data function activates the display mode for 
point scan data.

This mode is only available with the DDEPlus option and if 
the selected image contains point scan data.

A right-click on the point scan data table opens a context 
menu with edit options for the following functions:

– Labeling scan points in the active image
– Selection of columns to be displayed
– Saving the table in ASCII, HTML or XLS format

The function opens the Point Scan Data dialog window.

Structure The following figure shows the Point Scan Data dialog 
window with the following components:

Function The following table contains information on the compo-
nents of the Point Scan Data dialog window:

Component Function

 Label selected point
– Marks and labels the point of the image which is selected in the 

table.
– Opens the Label dialog window to set up the label settings.

 Label all selected points
– Marks and labels all selected points of the image with a consecu-

tive number. 
The numbers are assigned according to the index of the points. 
Thus, point 2 from the table will be labeled with the digit 2. If only 
one point in the table is selected, only that point will be labeled in 
the image. All other points will simply be marked.

– Opens the Label dialog window to set up line width and the color 
of the marker.

 Mark all points
– Shows all points in the image. 

The point selected in the table will be highlighted.
– Opens the Label dialog window to set up line width and the color 

of the marker.
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 Line marker
– Connects the first and last point with a line.
– Opens the Label dialog window to set up line width and the color 

of the line.

This function is useful to display concentration profiles.

Coordinates

– Image Displays the coordinates of the points in the table originating in the 
lower left corner of the image.

– DAC center Displays the coordinates of the points in the table originating from 
the center of the image.

– Stage Displays the coordinates of the points in the table as stage coordi-
nates if the system is connected to a motorized microscope stage.

Context menu

– Select all points 
[Ctrl] + [A]

Selects all points listed in the table.

– Edit item 
[F2]

For editing a point which is selected in the table.

– Save table 
[Shift] + [Ctrl] + [F2]

Opens a dialog window for saving the table as XLS, CSV or HTML 
format.

– Customize columns 
[Shift] + [Ctrl] + [C]

Opens the Customizing dialog window with two tabs to customize 
the columns.

–  Auto column widths Sets the widths of all columns automatically to fit the table within the 
window.

Component Function



Image processing Functions in the Tools menu

point electronic GmbH DISS 6 Software 199 / 206

Version: 6.4.0.0 Reference guide 26.02.2025

Measurement values window

Description In the measurement values window, the measured dis-
tances, radii and angles of the selected image are dis-
played as tables. The data may be saved either as XLS, 
HTML or TXT.

The function opens the Measurement Values dialog win-
dow.

Structure The following figure shows the Measurement Values dia-
log window with the following components:

Function The following table contains information on the compo-
nents of the Measurement Values dialog window:

Component Function

Distances tab Displays information on all measured distances in the selected 
image.

Radii tab Displays information on all measured radii in the selected image.

Angles tab Displays information on all measured angles in the selected image.

Columns Opens the Customizing dialog window to customize the table col-
umns.

Save Closes the dialog window.
All displayed measurement data are saved as tables in XLS, HTML or 
TXT format.
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Mix window

Description The Mix window function allows to overlay images, to com-
bine images into false color images or to color images.

The function opens the Mix Images dialog window with the 
False Colors and Merge tabs.

False colors tab The following figure shows the Mix Images dialog window 
with the False Colors tab:

In the False colors tab, elemental mapping images may be 
overlaid or combined into false color images.

The images to be mixed are assigned by Drag & Drop to 
the three color channel fields in the Mix window.

The images to be mixed must have the same dimensions 
and pixel resolution.

NOTICE

All three fields must be filled with images in the follow-
ing order: 1. the upper field 2. the center field 3. the 
lower field.
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Only gray scale images may be mixed and/or colored.

The colors may be set with the sliders.

Via Drag & Drop, a mixed image may be transferred from 
the dialog window into the DIPS work area or into an open 
layout.

Merge tab The following figure shows the Mix Images dialog window 
with the Merge tab:

The Merge tab contains two fields. Images may be as-
signed to the fields via Drag & Drop. The tab also contains 
an empty mix window to display the mixing result.

The images to be mixed must have the same dimensions 
and pixel resolution.

Gray scale images as well as color images may be mixed.

With the sliders, the weighting for each image for entering 
the mix field may be adjusted.

If the “complementary” checkbox is activated, the sliders 
move in mutual dependence.

NOTICE

Both fields must be filled with images in the following 
order: 1. the upper field, 2. the lower field.
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Via Drag & Drop, a mixed image may be transferred from 
the dialog window into the DIPS work area or into an open 
layout.



point electronic GmbH DISS 6 Software 203 / 206

Version: 6.4.0.0 Reference guide 26.02.2025

8 Calibration

Chapter overview

Purpose This chapter contains instructions that support you with cal-
ibrating the DISS 6 Software.

Contents This chapter contains the following information:

› Calibration of the magnification . . . . . . . . . . . . . . . . . 204
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Calibration of the magnification

Description For calculating the scale bar (Micron Bar) and for distance 
measurement in the image, the image acquisition uses the 
SEM magnification and a SEM-specific calibration constant.

To determine the SEM constant, it is necessary to carry out 
a calibration with a sample with known structures.

NOTICE

Mind authorizations!

You will need admin rights to carry out the calibration.

NOTICE

The precision of measurement depends on the linearity 
and accuracy of the magnification of the SEM.
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Steps Complete the following steps to calibrate the magnifica-
tion:

1. Set an image with a known structure in the SEM.
2. Start a slow scan with the following settings:

– Minimum Width 1000 pixels
– Activated Line synchronization

see “Slow Scan” on page 77
3. During the slow scan, press [Ctrl] + [Alt] + [C] to start 

calibration.
 A double cross with green lines appears in the im-

age acquisition window. The lines of the double 
cross will form a square.

 Additionally, the Calibration dialog window opens:

4. Adjust the vertical green lines to the known structure.
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By clicking and dragging the lines while pressing 
the [Ctrl] key, the lines of the double cross will form 
a square.

5. In the Calibration dialog window:
– Select the direction in the Orientation field.
– Enter the real distance value in the Real Distance 

field.

If the lines of the double cross do not form a 
square, the aspect ratio of the rectangular double 
cross will be displayed in the Y:X Ratio field.

If you enter the distance value without unit, the 
value is adopted in millimicronmeters. You may 
also enter the particular unit directly after the dis-
tance value.

6. Click the Save button in the Calibration dialog win-
dow to confirm the settings.
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